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Declarație 

 

Acest manual IQ Interactive Education Platform V5.2 se referă la toate tipurile de tablă interactivă, inclusiv 

fizice și virtuale, produse de Returnstar Interactive Technology Group Co., Ltd. 

 

Utilizați acest produs în strictă conformitate cu instrucțiunile de operare detaliate în acest manual, astfel 

încât să asigurați utilizarea corectă. Citiți cu atenție acest manual înainte de a instala produsul.  

 

Deschiderea coletului semnifică acordul de achiziționare a produsului, Returnstar nu va consimți returnarea 

coletelor deschise. 

 

Specificațiile produsului pot suferi modificări fără notificarea prealabilă. Imaginile din acest manual de 

utilizare pot diferi de produsul real. 

 

Returnstar își rezervă dreptul de a percepe oricând taxe pentru înlocuirea produsului, revizie și actualizare. 

Informațiile din acest manual pot fi modificate periodic fără notificarea în prealabil. Returnstar nu acordă 

nicio garanție cu privire la acest produs și declină orice garanții, exprese sau implicite, de vandabilitate și 

adecvare pentru un anumit scop. 

 

Notificare asupra mărcii comerciale 

 

Returnstar, IQ, IQClick și IQBoard sunt mărci înregistrate ale Returnstar Interactive Technology Group Co., 

Ltd.. Windows este marcă înregistrată a Microsoft Corporation.  
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Partea I Cuvânt înainte 

Capitolul 1 Prezentarea produsului  

IQ Interactive Education Platform este o platformă software de ultimă generație pentru demonstrații și 

instruire. Acesta conectează perfect toate tipurile de echipamente interactive de predare, de exemplu, toate 

tipurile de tablă interactivă, echipament tactil de predare, modul de proiecție interactiv, proiector interactiv, 

cameră de documente, echipament de pregătire a lecției și așa mai departe. Cu IQ Interactive Education 

Platform, diverse funcții puternice, precum cea de scriere „freehand”, adnotare, recunoașterea scrisului, 

diagrame, înregistrare ecran, animație, afișare pagină, răspuns interactiv, examen interactiv, vot, 

videoconferință, sunt accesibile profesorilor și demonstranților. Cu IQ Interactive Education Platform, devine 

ușor de creat o sală și o demonstrație vie și minunată.  

 

Software puternic: Pe lângă opțiunile bogate privind modul de răspuns în răspunsul interactiv și 

examinarea interactivă, IQ Interactive Education Platform vă oferă, de asemenea, toate instrumentele și 

arhiva de resurse în software-ul IQBoard.  

 

Efect optim: Cu IQ Interactive Education Platform, cursanții nu mai sunt simpli spectatori pasivi. 

Interacțiunea și entuziasmul sunt la un nivel ridicat atât în ceea ce privește predarea cât și învățarea. 

 

Ușor de utilizat: Lecțiile și testele pot fi pregătite de IQ Interactive Education Platform și PowerPoint. După 

lecții, IQ Interactive Education Platform scutește profesorii de sarcinile consumatoare de timp cu verificarea 

și marcarea automată a hârtiei de test. 

Capitolul 2 Instalarea/dezinstalarea, înregistrarea și actualizarea 

2.1 Cerințele sistemului 

Windows XP/2003/Vista/7/8  

Celeron 2.66 sau superior 

256MB RAM (512MB recomandat) 

Microsoft DirectX8.0 sau superior 

1G spațiu liber pe hard disk (pentru instalare completă) 

Rezoluția ecranului: 1024×768 (culoare 16biți sau mai mult) 

2.2 Instalarea 

2.2.1 Instalarea IQ Interactive Education Platform 

Faceți dublu clic pe “IQ Interactive Education Platform V5.2” în CD-ul de instalare, apoi urmați instrucțiunile 

de pe ecran pentru a instala software-ul. 
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2.2.2 Instalarea Software IQBoard Resource Library 

Faceți dublu clic pe “Software IQBoard Resource Library V5.0 (Full)” în CD-ul de instalare, apoi urmați 

instrucțiunile de pe ecran pentru a instala arhiva de resurse Resource Library. 

2.3 Dezinstalarea 

2.3.1 Dezinstalarea IQ Interactive Education Platform 

1. Există trei metode pentru a începe dezinstalarea IQ Interactive Education Platform: 

1) Apăsați “Start > Programs > IQ Interactive Education Platform V5.2>Uninstall”; 

2) Se deschide “Control Panel”, selectați “Add/Remove Programs”, și în lista Currently Installed Programs, 

selectați “IQ Interactive Education Platform V5.2”, apoi apăsați “Remove”; 

3) Apăsați din nou “IQ Interactive Education Platform V5.2” pe CD-ul de instalare. 

2. Urmați instrucțiunile de pe ecran pentru a dezinstala software-ul. 

 

2.3.2 Dezinstalarea arhivei IQ Interactive Education Platform Library 

1. Există trei metode pentru a începe dezinstalarea IQ Interactive Education Platform Library: 

1) Atunci când dezinstalați IQ Interactive Education Platform, sistemul va solicita să dezinstalați IQ 

Interactive Education Platform Resource Library în același timp; 

2) Deschideți “Control Panel”, selectați “Add/Remove Programs” și, în lista Currently Installed Programs, 

selectați “IQ Interactive Education Platform Library V5.0 (Full)”, apoi apăsați “Remove”; 

3) Apăsați din nou “IQ Interactive Education Platform Library V5.0 (Full)” pe CD-ul de instalare. 

2. Urmați instrucțiunile de pe ecran pentru a dezinstala arhiva de resurse. 

2.4 Înregistrarea 

2.4.1 Testarea  

Puteți descărca IQ Interactive Education Platform de pe pagina noastră web http://www.iqboard.net. După 

ce ați finalizat descărcarea, instalați software-ul, apoi îl puteți încerca imediat. IQ Interactive Education 

Platform are 30 testări, care se numără în momentul în care porniți software-ul. După expirarea testărilor, 

înregistrați dacă doriți să continuați utilizarea software-ului. 

2.4.2 Înregistrarea 

Vă oferim patru modalități de înregistrare a IQ Interactive Education Platform. Vă puteți înregistra după 

Product SN, USB Key, verificare hardware sau verificare receptor. 

Notă: Puteți, de asemenea, alege Repair în fereastra Uninstallation pentru a repara 

erorile în cea mai recentă instalare. 

http://www.iqboard.net/
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2.4.2.1 Înregistrare după numărul de serie al produsului 

Atunci când porniți varianta neînregistrată a IQ Interactive Education Platform, va apărea următoarea 

fereastră Register. Puteți deschide, de asemenea, fereastra Register prin selectarea “Register” pe 

pictograma barei de activități. 

 

Introduceți numărul de serie (obținut la achiziționarea software-ului), numele utilizatorului, numărul de 

telefon, e-mail și țara în fereastra de înregistrare, apoi apăsați “Register” pentru a finaliza înregistrarea. 

După înregistrare, software-ul va indica pe câte computere puteți înregistra software-ul. Dacă nu puteți 

înregistra software-ul pe numărul de computere stipulat în licența software-ului, motivele pot fi: 

1. Respectivul SN a fost utilizat de alte persoane; 

2. Comercianții vând ilegal, contactați organizația consumatorilor pentru despăgubiri. 

2.4.2.2 Înregistrarea după tasta USB sau receptor 

Dacă doriți înregistrarea după cheia USB, conectați cheia USB accesoriu sau receptorul în orice port USB 

din computer. Dacă nu apare nicio fereastră Register atunci când porniți IQ Interactive Education Platform, 

înregistrarea s-a făcut cu succes. În cazul în care au expirat cele 30 de încercări, computerul vă va solicita 

să realizați înregistrarea de fiecare dată când porniți software-ul, aici puteți, de asemenea, conecta cheia 

USB sau receptorul înainte de a porni IQ Interactive Education Platform pentru înregistrare. 

Notă: Metoda de înregistrare este opțională, potrivit nevoii clientului. 



Returnstar Interactive Technology Group Co., Ltd. 

 

 8 

 

 

2.4.2.3 Înregistrarea după verificare hardware 

IQ Interactive Education Platform V5.2 poate fi înregistrată prin conectarea oricărei IQBoard, cu excepția 

seriei virtuale. Dacă doriți înregistrarea pin verificare hardware, instalați driver-ul relevant al tablei și 

conectați tabla cu PC-ul. Dacă nu apare fereastra Register atunci când porniți IQ Interactive Education 

Platform, înregistrarea a reușit. În cazul în care au expirat cele 30 de încercări, computerul vă va solicita să 

realizați înregistrarea de fiecare dată când porniți software-ul, aici puteți conecta, de asmenea, tabla cu 

PC-ul înainte de a porni IQ Interactive Education Platform pentru înregistrare. 

2.5 Actualizarea 

După pornirea IQ Interactive Education Platform, sistemul va verifica automat dacă este disponibil pachetul 

de actualizare. Dacă da, va solicita actualizarea. Utilizarea este după cum urmează: 

1. Apăsați “Yes” pentru actualizarea software-ului, apăsați “No” dacă nu doriți să actualizați acum. Puteți 

apăsa pe pictograma barei de activități și selectați “Update” pentru a introduce fereastra Update. Dacă este 

prima dată când actualizați software-ul, ar putea fi necesar să introduceți informațiile de utilizator. 

 

Notă: Dacă îndepărtați cheia USB sau receptorul atunci când utilizați IQClick Software, va apărea un mesaj ca 

mai jos. 
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2. Apăsați “Update” în fereastra Update pentru a descărca pachetul de actualizări. 

 

3. După finalizarea descărcării, procesul de actualizare va începe automat. Dacă nu este necesară 

actualizarea IQ Interactive Education Platform, apăsați “Exit” pentru a ieși din această fereastră. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notă: 

1. Doar software-ul IQBoard înregistrat poate fi actualizat. 

2.  Dacă serviciul de actualizare a expirat, trebuie să achitați taxa de actualizare pentru a 

continua actualizarea software-ului. 

3. Atunci când se actualizează software-ul, dacă apare mesajul în software “You cannot update 

unregistered software”, dezinstalați software-ul și înregistrați din nou, apoi actualizați software-ul.  
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Partea II Ghid de utilizare IQBoard 

Capitolul 1 Pornirea software-ului IQ Interactive Education Platform 

Puteți face dublu-clic pe comanda rapidă de pe desktop “IQ Interactive Education Platform” pentru a porni 

IQ Interactive Education Platform după cum urmează:  

 

IQ Interactive Education Platform oferă profesorilor un cont de utilizator temporar pentru a începe activitatea 

temporară fără a stabili informații de clasă. Puteți adăuga alte conturi de utilizator din "Teacher Settings", 

după autentificarea administratorului. 

 

 

Notă: Contul de utilizator implicit pentru administrator este „administrator”, parola este 

nulă. După prima autentificare, schimbați parola și păstrați-o în timp.  
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Bara de instrumente mobilă 

Bara de instrumente mobilă vă permite să accesați rapid instrumentele și facilitățile utilizate frecvent. Spre 

deosebire de bara de instrumente tradițională, bara de instrumente mobilă poate fi plasată oriunde pe ecran 

și poate fi mutată. 

 

Schimbați poziția barei de instrumente mobilă: Oriunde se află bara de instrumente mobilă, există o 

săgeată pentru schimbarea poziției  pe latura opusă. Apăsați această săgeată pentru a muta bara de 

instrumente mobilă dintr-o parte în alta. Această funcție vă permite să accesați convenabil bara de 

instrumente mobilă pe un ecran mare. 

Ascunderea barei de instrumente mobilă: Mutați bara de instrumente mobilă în orice margine a ecranului 

iar bara de instrumente se va ascunde automat. Pentru a afișa bara de instrumente, mutați cursorul pe 

marginea în care este ascunsă bara de instrumente, sau apăsați butonul . 

Capitolul 2 Moduri de lucru 

IQ Interactive Education Platform Software are 3 moduri de lucru principale: modul Windows, modul Board și 

modul Show. În modul Windows, puteți utiliza normal computerul, puteți face adnotări pe ecran cu cerneală 

digitală și puteți utiliza unele instrumente de bază în bara de instrumente mobilă. Modul Board afișează 

paginile tablei pe ecran. Dacă suportul de curs conține efecte de animație sau întrebări interactive, puteți 

utiliza modul Show pentru afișare. 
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2.1 Modul Windows 

Puteți accesa modul Windows apăsând butonul  din bara de instrumente mobilă sau puteți minimiza 

fereastra principală a IQ Interactive Education Platform.  

 

 

Următoarele reprezintă funcții utile în modul Windows: 

Annotate on screen (Adnotare pe ecran): Selectați orice instrument de schițare din bara de instrumente 

mobilă pentru a accesa modul de adnotare, va apărea un cadru de adnotare în jurul ecranului. Puteți realiza 

adnotări pe ecran cu cerneală digitală. 

Operate Windows (Operare Windows): Atunci când nu sunteți în modul de adnotare, puteți opera normal 

computerul așa cum procedați, de obicei, cu mouse-ul. În modul de adnotare, puteți de asemenea realiza 

operarea normală a computerului apăsând butonul  din bara de instrumente mobilă. 

Clear annotation (Ștergere adnotare): Apăsați  colțul din dreapta jos, toate adnotările create de IQ 

Interactive Education Platform vor fi șterse. 

Auto-clear annotation (Ștergere automată adnotare): Toate adnotările create de IQ Interactive Education 

Platform vor fi șterse automat atunci când schimbați sau închideți fereastra. Pentru a activa această funcție, 

selectați “Automatically Clear Desktop Annotation” în “Alte setări” din “System Settings”. Această funcție 

este selectată implicit. 
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Capture Screen (Captură ecran): Apăsați butonul  în colțul din dreapta jos, puteți realiza o captură a 

ecranului curent în pagina tablei în modul Board. Toate adnotările create de IQ Interactive Education 

Platform pot fi editate din nou. 

Save annotation to Office document (Salvare adnotare în document Office): În cazul în care ați deschis 

un document Word, Excel sau PowerPoint și ați realizat adnotarea direct în acesta, puteți apăsa butonul  

în colțul din dreapta jos pentru a salva adnotarea în acest document Office în forma originală.  

 
Mergeți la pagina anterioară sau următoare in Office file (Mergeți la pagina anterioară sau următoare 

în fișierul Office): Puteți apăsa butonul  sau din bara de instrumente mobilă pentru a merge la 
pagina anterioară sau următoare pentru fișierul Office afișat. 

 

Exit annotating (Ieșire din adnotare): Apăsați butonul  în colțul din dreapta jos pentru a închide cadrul 

de adnotare. 

Notă: Implicit, butoanele  și nu sunt afișate în bara de instrumente mobile (Floating Tools), le 

puteți adăuga manual prin “System Setting > Toolbars”. 
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2.2 Modul Board 

Apăsați butonul  din bara de instrumente mobilă pentru accesarea modului Board, inclusiv Mod full 

screen (ecran complet), mod ecran Windows și mod Frame Screen (cadru ecran). În acest mod, există un 

coș în colțul din dreapta jos al paginii tablei. Puteți trage un obiect din pagină în coș pentru a-l șterge, sau 

puteți selecta un obiect, apoi apăsați pe pictograma coșului pentru a-l șterge. 

 

Mod ecran Windows 

Porniți IQ Interactive Education Platform, va accesa automat modul ecran Windows. Puteți folosi 

instrumentele din fereastra principală și bara de instrumente mobilă în acest mod. 

 

Mod Frame Screen (cadru ecran) 

Puteți utiliza instrumentele din fereastra principală și bara de instrumente mobilă în acest mod. Pentru a intra 

în modul Frame Screen (cadru ecran), selectați “View > Frame Screen”. 
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Mod full screen (ecran complet) 

Apăsați  bara de instrumente Common Tools sau Resource Panel, sau selectați “View > Full Screen” 

pentru a accesa modul full screen (ecran complet). 

 

În acest mod, puteți utiliza instrumentele din Bara de instrumente mobilă. Pentru a ieși din ecran complet, 

apăsați  în colțul din stânga jos al ecranului. 

2.3 Modul Show 

Dacă suportul de curs conține efecte de animație sau întrebări interactive, prezentați suportul de curs în 

modul Show. Pe durata prezentării, puteți face adnotări cu instrumentele de adnotare din bara de 

instrumente mobilă sau alte operațiuni auxiliare, dar nu puteți manipula obiecte, cum ar fi copy, paste și 

move (copiere, lipire şi mutare). 
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Pentru a personaliza modul Show, apăsați “Show Mode > Set Up Show” în bara de meniu. 

 

Page Settings (Setări pagină): Puteți alege să afișați toate paginile sau pagina(ile) aleasă(alese). 

Loop Show (Prezentare buclă): Suportul de curs va rula continuu până când apăsați tasta “Esc”. 

Auto Scroll (Derulare automată): Puteți seta intervalul de timp de întoarcere automată a paginii. 

Turn Page (Întoarce pagina): Apăsați  sau  în colțul din stânga jos pentru a schimba în pagina 

anterioară sau următoare.  

Puteți selecta “One-click on Page to Play Animation” pentru a întoarce pagina printr-o singură apăsare pe 

partea albă a paginii. 

 

2.4 Mod Dual-user (doi utilizatori)  

1. Pentru a activa modul Dual-user, selectați “Tools > Dual user” în bara de meniu, sau apăsați în bara 

de instrumente Common Tools. 

Mod Dual-user pentru IQBoard 

IQBoard ET-D 

IQBoard ET-D Pro 

 

Notă:  

1. Implicit, toate paginile vor fi afișate de la început la sfârșit fără Loop Show și Auto Scroll. 

2. Intervalul de timp pentru Auto Scroll este de 1-99 secunde. 
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IQBoard PS-D 

 

IQBoard LT M2 

IQBoard DVT 

IQBoard IR-D 

 Mesaj:În modul Dual-user (Full screen), doi 

utilizatori pot folosi simultan opțiunile select, pencil, 

brush pen, pen, washing brush, board brush, 

eraser, line, shape (formă) și fill (umplere). 

 

Mod Dual-user (ecran divizat) 

 

Mod Dual-user (ecran complet)
 

2. În modul Dual-user, două instrumente de scris funcționează simultan pe tablă; cu toate acestea, Teacher 

Pen și Student Pen pot controla propria bară de instrumente mobilă.  

            

 Scrisul de mână va fi recunoscut automat în timp ce Student Pen utilizează “Handwriting recognition”. 

 Guma de șters (eraser) (cu excepția “Erase All”) poate curăța cerneala digitală a celorlalți atunci când 

acest proces de scriere este pus pe pauză. 

 Atunci când se alege “Erase All”, Teacher Pen poate curăța cerneala digitală atât a instrumentului 

Teacher Pen cât și al instrumentului Student Pen, în timp ce Student Pen își poate curăța doar propria 

cerneală digitală. 

 În modul Dual-user, mouse-ul poate controla doar bara de instrumente mobilă a trainerului. 

 Student Pen nu poate controla fereastra mobilă sau alte instrumente, cum ar fi instrumentele cronometru 

(timer) sau ecran (screen). 

 Tastele scurte din stânga pe care trainerul le poate utiliza în modul Dual-user: Select, Pens (faceți dublu 

clic pentru a schimba între patru culori), Eraser, scurtături aplicație, scurtături instrument și Start 

(prezintă bara de instrumente mobilă minimizată de trainer); taste scurte dreapta pe care cursantul le 
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poate utiliza în modul Dual-user: Select, Pens, Eraser și Start (prezintă bara de instrumente mobilă 

minimizată de student). 

3. Pentru a ieși din modul Dual-user: trebuie să utilizați Teacher Pen pentru a apăsa pe butonul din colțul din 

stânga jos al tablei. Dacă Student Pen a fost manipulat în modul Dual-user, atunci când Teacher Pen 

dorește să iasă din modul Dual-user, va apărea o fereastră popup ca mai jos: 

 

2.5 Modul Multi-user  

În modul Board, pot scrie mai mulți utilizatori simultan și pot recunoaște gesturi precum Zoom, Rotire, etc., 

ale dispozitivelor de intrare care suportă Windows multi-touch. 

 

Înainte de a utiliza modul Multi-user, asigurați-vă că: 

1. Multi-touch este disponibil în tabla sau ecranul tactil pe care le folosiți.   

2. Sistemul de operare pe care îl utilizați să fie WIN7 sau WIN8. 

3. Software-ul IQBoard a fost înregistrat de utilizator multiplu SN sau tasta USB. 

4. Modul Multi-user poate fi activat prin conectarea computerelor cu IQBoard DVT, IQBoard IRx-D și 

IQBoard LT, fără SN sau tasta USB. 

 

Pentru a utiliza modul Multi-user: 

1. Activați modul Multi-user potrivit celor de mai sus, apoi intrați în modul Board sau modul full screen (ecran 

complet) în Software IQBoard. 

2. Selectați Pen din bara de instrumente Drawing Tools, cum ar fi Pencil, Brush Pen, Pen, Board Brush, 

Washing Brush și Creative Pen, apoi mai mulți utilizatori pot scrie simultan. 

3. Puteți aplica Rotate sau Zoom pe unul sau mai multe obiecte selectate în pagina tablei prin Gesture 

Recognition în Windows OS. 

4. Bifați Inertial Movement în “System Setting > 0ther Settings”, obiectul va ajusta viteza automat, potrivit 

vitezei de mișcare atunci când se mută obiectul. 
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Modul 

Multi-user 

 
Indicații: Multi-utilizatorii trebuie să folosească același instrument de 

scriere pentru a scrie în modul Multi-user. 

Gesture 

Recognition 

(Zoom și 

Rotate) 

            
Zoom                          Rotate 

Inertial 

Movement 

 

Selectați și trageți obiectul pentru a-l deplasa înainte, automat. 

2.6 Modul ME2 

Modul ME2 poate fi activat prin conectarea computerelor cu IQBoard ME2 Interactive Education System. În 

modul ME2, sunt disponibile Single Board (A/B), Dual Board Sync (A=B), Dual Board Interaction (A&B) și 

Dual Board Extension (A+B). 

 

Înaintea utilizării modului ME2: 

1) Conectați IQBoard ME2 la computer potrivit “ Manualului de utilizare IQBoard ME2 Interactive 
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Education System”.  

2) Apăsați pictograma modului ME2 în bara de instrumente Common Tools, apoi va apărea fereastra 

modului ME2, după cum urmează: 

 

 

3) Apăsați un mod pe care doriți să îl accesați. Implicit, tabla din stânga este tabla principală, în timp ce 

tabla din dreapta este tabla secundară. 

 

Pentru utilizarea modului ME2: 

Interacțiune Dual Board (A&B) 

1) Software IQBoard se va afișa implicit pe tabla secundară. Între timp, puteți deschide orice fișier aveți 

nevoie, pe tabla principală, fără vreo interferență. 

2) Apăsați și țineți apăsată bara de titlu a ferestrei pe ET Pen pentru a o trage pe oricare dintre table doriți. 

3) Atunci când accesați modul Dual-user, 1 Teacher Pen și 1 Student Pen se pot utiliza simultan în 

Software IQBoard. Dacă 1 Student Pen scrie pe software-ul IQBoard, 1 Teacher Pen poate opera în 

același timp și pe cealaltă tablă. 

 

 

Extensie Dual Board (A+B) 

Două zone de proiecție sunt combinate într-un ecran complet care face posibilă prezența mai multor 
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participanți la interacțiuni. Software-ul IQ va fi extins pe ambele table și se pot realiza numeroase operațiuni 

astfel. 

1) În software-ul IQBoard este activă scrierea cu un singur instrument (Single pen) în orice colț al acestui 

ecran complet. 

2) Puteți accesa Dual Page Display, blocând o pagină în timp ce întoarceți cealaltă pagină pentru a 

compara elementele predării. 

3) Va apărea o fereastră de opțiuni pentru selectarea a doi (Two Users) sau patru utilizatori (Four Users) 

atunci când accesați modul Dual-user.  

Two Users, 1 Teacher Pen și 1 Student Pen se pot utiliza în orice colț al acestui ecran complet în 

software-ul IQBoard.  

Cu Four Users, fiecare tablă suportă scrierea cu 1 Teacher Pen și 1 Student Pen, astfel că toate cele 

patru instrumente ET Pens se pot utiliza pe table în același timp (doar cu Pencil, Brush Pen, Pen, Board 

Brush și Creative Pen). 

 

 

Dual Board Sync (A=B) 

Operațiile de pe una dintre table se pot afișa și pe cealaltă în timp real, astfel că fiecare student poate vedea 

clar atunci când conținutul uneia dintre table este modificat de către profesor sau altcineva.  

 

Atunci când accesați modul Dual-user, 1 Teacher Pen și 1 Student Pen se pot utiliza pe aceeași sau pe două 

table simultan. 

 

 

Single Board (A/B) 

Un singur proiector este necesar și puteți activa oricare tablă doriți. Toate funcțiile IWB tradiționale se pot 

realiza în acest mod. 
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Capitolul 3 Utilizarea IQ Interactive Education Platform 

3.1 Managementul fișierelor 

New (Nou) : Creează un fișier nou. 

Open (Deschide) : Puteți deschide fișiere .cdf, .cdp, .pdf, .doc, .ppt, .xls, .docx, .pptx, .xlsx, iwb și csv.  

 

 

Close (Închidere): Apăsați “File > Close” în bara de meniu pentru a închide fișierul curent. 

Save/Save as (Salvare/Salvare ca) : Puteți salva fișierul curent în numeroase formate, 

inclusiv .bmp, .emf, .wmf, .pdf, .cdp, .jpg, .html, .gif, .png, .tif, .doc, .ppt, .xls, .docx, .xlsx, .pptx, .cdf. și iwb. 

Fișierul va fi denumit automat conform orei curente. 

Notă: Puteți trage, de asemenea, fișierele video și documentele office 

(.doc, .docx, .ppt, .pptx, .xls, .xlsx) direct pe pagina tablei pentru deschidere. 
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Save as Template (Salvare ca șablon): Dacă modul de prezentare (layout) al fișierului curent poate fi 

utilizat frecvent pe viitor, îl puteți salva ca șablon, care poate fi extras din fila Template. Apăsați “File > Save 

as Template” în bara de meniu pentru salva fișierul curent ca șablon. 

 

 

 

Multiple Tabs (File multiple): Puteți crea sau deschide numeroase fișiere în același timp în software 

IQBoard și apăsați filele pentru a comuta între acestea. 

Notă: Puteți salva doar un fișier existent precum formatele .bmp, .emf, .wfm, .jpg, .gif, .png și 

.tif. în sistemul Windows, puteți salva doar în contul Administrator fișiere .doc, .xls, .ppt, .docx, 

.xlsx și .pptx. 
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Encrypt a File (Criptare fișier): Puteți cripta fișerul .cdf. fișierul criptat nu se poate deschide fără parola 

corectă. Apăsați “File > Encrypt” în bara de meniu pentru a cripta fișierul curent. 

 

 

 

Auto-save (Salvare automată): Funcția de salvare automată poate minimiza pierderea datelor în cazul 

problemelor neprevăzute. Apăsați “File > Auto-save” în bara de meniu pentru a seta funcția Auto-save. 

Notă: Parola poate fi orice caracter (cu distingere între litere mari și mici-case sensitive), 

cu dimensiunea de până la 8 caractere. Asigurați-vă că ați reținut parola după setare. 

Compania noastră nu oferă servicii de spargere a fișierelor criptate. 
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Print (Imprimare): Puteți imprima un fișier în IQ Interactive Education Platform. Apăsați “File > Printer 

Options” pentru a seta imprimanta, apoi apăsați “Print” sau “Print Current Page” pentru a imprima paginile 

de care aveți nevoie. 

Send (Trimitere): Apăsați “File > Send Mail” în bara de meniu sau “  > Send Mail” în bara de instrumente 

mobilă pentru a trimite fișierul curent ca atașament la e-mail în formatele .cdf, .pdf, .ppt. 

3.2 Managementul paginilor 

Insert (Introducere) : Introduceți o pagină albă după cea curentă. 

Delete (Ștergere) : Ștergeți pagina curentă. 

Copy/Cut/Paste (Copiere/Tăiere/Lipire): Selectați pictograma paginii pe care doriți să o copiați/tăiați/lipiți 

în fila Page. 

 

Clone (Clonare): Apăsați săgeata din meniu pe pictograma paginii și selectați “Clone Page”. Apoi, faceți clic 

dreapta pe pictograma paginii și selectați “Clone Page”. Pagina clonată apare imediat după pagina curentă. 
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Clear(Golire): Elimină tot conținutul paginii curente. 

 

 

Reset Page (Resetare pagină): Atunci când re-editați o pagină salvată, apăsați săgeata din meniu pentru a 

selecta “Reset Page”, această pagină poate fi restabilită ca mai înainte. 
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Lock/Unlock a Page (Blocare/deblocare pagină): Pe durata afișării Dual Page, puteți selecta pictograma 

paginii pe care doriți să o blocați și apăsați săgeata din meniu pentru a selecta “Lock Page”. Atunci când 

schimbați paginile, această pagină este blocată, în timp ce cealaltă poate fi mutată în modul de afișare Dual 

Page.  

 

Pentru a debloca o pagină, selectați “Unlock page” în săgeata pictogramei din meniu aferentă. 

 

 

Insert Page Number (Introducere număr pagină): Apăsați “Insert > Page Number” în bara de meniu, 

atunci puteți seta poziția numărului paginii și puneți numărul paginii în fereastra Insert Page Number care 

apare. 

 

Display (Afișare): Mergeți la pagina anterioară sau următoare. 
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Move (Mutare) : O pagină a tablei poate fi extinsă la infinit. Puteți muta o pagină pentru a avea mai mult 

spațiu sau puteți afișa orice parte a paginii pe ecran.  

Return (Revenire) : Restabilește o pagină mutată în poziția sa inițială. 

Zoom: Implicit, paginile tablei sunt afișate la dimensiunile propriu-zise. Dar puteți folosi instrumentele zoom 

pentru a mări sau micșora dimensiunea paginii tablei. 

1) Zoom in/ Zoom aut (Mărire/micșorare) : După ce cursorul mouse-ului devine lupă, apăsați pagina 

pentru mărire sau micșorare. Atunci când apăsați , puteți de asemenea, ține și trage un pătrat pentru 

a focaliza pe o zonă anume. 

2) Restore (Restabilire): Restabilește pagina la 100%. Puteți selecta, de asemenea, de la 50% la 200% din 

meniul drag down. 

3) Fit Page (Adecvare pagină): Faceți întreaga pagină să corespundă afișajului dvs. 

Background (Fundal) : Puteți specifica o singură culoare, gradient, model de grilă sau o 

imagine(.jpg, .jpeg, .wmf, .emf, .png, .bmp) ca fundal de pagină. 

 

Save (Salvare): IQ Interactive Education Platform poate salva toate paginile tablei în formate .cdf , .cdp și 

iwb. Puteți, de asemenea, salva pagina tablei în alte formate, inclusiv format document (.doc, .ppt, .xls), 

format webpage (.html) și format imagine (.bmp, .emf, .wmf, .jpg, .gif, .png, .tif,). Obiectul în fișier .cdf poate 

fi reeditat. 
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Save a Page as Template (Salvare pagină ca șablon): Dacă modul de prezentare (layout) al paginii 

curente a tablei se poate utiliza frecvent pe viitor, puteți de asemenea, salva ca șablon, care se poate 

extrage din fila Template. IQ Interactive Education Platform va denumi fișierul conform orei curente. 

 

3.3 Crearea obiectelor 

3.3.1 Instrumente de schițare liberă (Freehand Drawing) 

Instrumentele Freehand Drawing sunt cele mai frecvent utilizate instrumente, cu care puteți realiza adnotări, 

puteți scrie și desena pe ecranul interactiv. Sunt oferite șapte instrumente Freehand Drawing, inclusiv 

Pencil , Brush Pen , Pen , Washing Pen , Broad Pen , Creative Pen  și Magic Pen . Puteți ajusta 

fiecare proprietate dacă este necesar. 

Obiectele trasate cu Magic Pen  se vor estompa în 8 secunde. Magic Pen are, de asemenea, opțiunea de 

recunoaștere a instrumentului pentru a deschide Reveal Screen, Spotlight, Magnifier și chiar pentru a șterge 

un obiect trasând formele date. 
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Puteți personaliza proprietățile instrumentelor Freehand Drawing, după cum urmează. 

Color (Culoare), Thickness (Grosime), Transparency (Transparență): Faceți dublu clic pe orice buton de 

culoare, grosime sau transparență sau apăsați săgeata din meniu  a secțiunilor pentru ajustare. 

      

Arrow Effect (Efect pe săgeată): Numeroase efecte pentru săgeată sunt oferite pentru instrumentul Pencil, 

instrumentul Creative Pen și instrumentul Magic Pen. Apăsați săgeata din meniu în secțiunea Arrow, apoi 

selectați efectul de pe săgeată pe care îl doriți din lista Arrow Effect. Puteți apăsa  pentru a 

personaliza cu propriile stiluri de linii. 

Shape Recognition (Recunoașterea formei): Instrumentul Pencil are, de asemenea, funcție Shape 

Recognition. Dacă activați această funcție, forma desenată de Pencil va fi refăcută automat la linie solidă 

(Solid Line), arc (Arc), cerc (Circle), dreptunghi (Rectangle), triunghi (Triangle) sau poligon (Polygon), iar 

liniile solide învecinate vor fi automat combinate în poligoane. Pentru activarea acestei funcții, apăsați  

pe bara de proprietăți (Properties). Puteți apăsa și trage orice punct de colț pentru modificarea formei. 

 

 Notă: 

1. Broad Brush este diferit de alte instrumente Freehand Drawing din setările culorii. 

Există în total 6 butoane pentru culoare. Prin selectarea unei culori pentru fiecare buton 

de culoare, veți obține un efect combinat de scriere de 6 culori.  

2. Dacă culoarea de fond este aceeași precum culoarea instrumentului, software-ul va 

reseta instrumentul la culoarea opusă. 

3. În modul Windows, transparența instrumentelor de desenat este 0%.  
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Tool Recognition (Recunoașterea instrumentului): Instrumentul Magic Pen are, de asemeena, funcția de 

recunoaștere a instrumentului (Tool Recognition). Dacă activați această funcție, puteți deschide Spotlight, 

Magnifier, Reveal Screen și Object Eraser cu Magic Pen. 

 

 

Desenați un cerc pentru a deschide Spotlight. 

 

Desenați un pătrat pentru a deschide Magnifier. 

        

Desenați o săgeată către stânga sau dreapta 

pentru a deschide Reveal Screen 

(stânga-dreapta). 

 

Desenați o săgeată care indică în sus sau în jos 

pentru a deschide Reveal Screen (Sus-jos). 

  

 

Desenați o săgeată oblică pentru a deschide 

Reveal Screen (toate direcțiile). 

 

Ștergeți obiectul. 

3.3.2 Liniile  

Sunt oferite diferite tipuri de linii drepte. Proprietățile liniilor pot fi modificate, de asemenea. 

 

Color, Thickness, Transparency: Faceți dublu clic pe orice buton de culoare, grosime sau transparență 

sau apăsați săgeata din meniul  secțiunilor pentru ajustare. 
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Line Effect (Efect pe linie): Apăsați săgeata din meniul secțiunii Line apoi selectați efectul liniei dorit din 

listă. Puteți apăsa, de asemenea,  pentru a personaliza propriile stiluri de linie. 

     

Show Length (Arată lungimea): Atunci când adăugați o linie la pagina tablei, puteți afișa lungimea liniei. 

Apăsați  în bara Properties apoi selectați “Show Length”.  

Puteți seta unitatea și cifrele zecimale ale lungimii din “Length Settings”. 

 

3.3.3 Forme  

Sunt oferite diferite tipuri de forme 2D și 3D. Puteți personaliza proprietățile instrumentului Shapes. 
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Color, Thickness, Transparency: Faceți dublu clic pe orice buton de culoare, grosime sau transparență 

sau apăsați săgeata din meniul secțiunilor  pentru ajustare. 

       

Shape Style (Stilul formei): 3 butoane de formă sunt oferite în bara Properties a instrumentului Shapes, 

inclusiv Rectangle, Triangle și, implicit, Circle. Pentru aplicarea altor forme, faceți dublu clic pe orice formă 

de buton sau apăsați săgeata din meniul secțiunii Shape pentru a selecta una. 

 

Other Settings (Alte setări): Apăsați  în bara Properties pentru a realiza mai multe setări ale formelor. 



Returnstar Interactive Technology Group Co., Ltd. 

 

 34 

 

3.3.4 Funcții  

Sunt prevăzute peste 20 de tipuri de grafice de funcție. Apăsați instrumentul Function pentru a selecta unul 

dintre graficele de funcție disponibile, apoi apăsați unde doriți să amplasați graficul funcției pe ecran.  

 

Puteți apăsa în zona curbei funcției pentru a selecta doar curba funcției; puteți, de asemenea, apăsa în zona 

sistemului de coordonate pentru a selecta întregul grafic de funcție. 

 

Funcțiile pot fi, de asemenea, personalizate. 

Color, Thickness, Transparency: Faceți dublu clic pe orice buton de culoare, grosime sau transparență 

sau apăsați săgeata din meniul secțiunilor  pentru ajustare. 

       

Function Exapăsațiion (Exprimare funcției): Sunt prevăzute diverse expresii de funcție în secțiunea 

Function. Pentru a personaliza propria expresie a funcției, apăsați “Customized” pentru a defini funcția, 

domeniul, valoarea scalei și alte setări. 



Returnstar Interactive Technology Group Co., Ltd. 

 

 35 

 

Share Coordinate System (Partajare sistem de coordonate): Puteți pune laolaltă toate funcțiile într-un 

singur sistem de coordonate apăsând  la partea inferioară a barei Properties. Dacă Share Coordinate 

System este deja selectat, puteți apăsa din nou pentru anulare. 

 

3.3.5 Punct la punct  

Acest instrument vă permite să creați un poligon sau o linie frântă. Puteți schimba între acestea de la  în 

bara Properties. Pentru a crea un poligon sau o linie frântă, apăsați instrumentul Point to Point și apăsați 

puncte diferite pentru crearea unui poligon sau liniii frânte. Faceți dublu clic pe ultimul punct pentru a finaliza 

poligonul sau linia frântă. Puteți de asemenea, suprapune ultimul punct cu primul pentru a realiza o formă. 

Toate punctele pot fi șterse. 
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Instrumentul Point to Point poate fi personalizat. 

Color, Thickness, Transparency: Faceți dublu clic pe orice buton de culoare, grosime sau transparență 

sau apăsați săgeata din meniul  secțiunilor pentru ajustare. 

       

OTher Settings (Alte setări): Apăsați  în bara Properties pentru mai multe setări. 

 

 

3.3.6 Tabel  

Pentru a crea un tabel, apăsați  și setați culoarea cadrului, grosimea, transparența, numărul rândului și 

coloanei în meniul nivelului secundar. Apoi creați un tabel apăsând pe locul în care doriți să îl așezați pe 

ecran și trăgând până când tabelul are dimensiunea pe care o doriți. 

 Notă: Show Length este disponibilă doar pentru linia frântă. 
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3.3.6.1 Personalizarea tabelului 

Color, Thickness, Transparency: Faceți dublu clic pe orice buton de culoare, grosime sau transparență 

sau apăsați săgeata din meniul  secțiunilor pentru ajustare. 

       
Row and Column Number (Număr rând și coloană): Puteți selecta numărul rândului și coloanei de la 1 la 

20. Introduceți direct numerele necesare sau modificați-le de la butoanele cu săgeată. 

 

3.3.6.2 Utilizarea tabelului 

 

După selectarea unei celule, următoarele operațiuni pot fi disponibile: 

Input Text (Introducere text): Puteți face dublu clic pe celulă pentru a introduce text. 

Insert Row/ Insert Column (Introducere rând/ coloană): Un nou rând sau o nouă coloană va apărea 

lângă cel(cea) existent(ă). 

Delete Row/Delete Column (Ștergere rând/ coloană): Rândul sau coloana selectat(ă) va fi șters(ștearsă). 

Split (Divizare): Introduceți numerele rândului sau coloanei pe care doriți să îl(o) divizați și aplicați 

divizarea. 

Merge (Fuzionare): Selectați mai multe celule pentru a le fuziona. 
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Move (Mutare): Apăsați pătratul  în colțul din stânga sus al tabelului, apoi trageți tabelul într-o altă 

poziție pe pagină. 

New Table (Tabel nou): Dacă selectați mai multe celule și le trageți în poziție diferită pe pagină, veți crea un 

tabel nou care constă în celulele selectate și conținutul acestora. 

 

Add Objects to Cell (Adăugați obiecte la celulă): Selectați obiectul țintă și trageți în celula din tabel. 

 

Move Object from Cell (Mutare obiect din celulă): Selectați obiectul țintă și trageți dintr-o celulă în alta, 

sau în pagină. 

 

3.3.7 Umplere  

Puteți umple culoare, gradient, model sau imagine (bmp, jpg, gif, png, emf, wmf, ico) în orice formă 

geometrică închisă.  

              

Culoare                                  Gradient 

             

Model                               Imagine 
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Fill with Color (Umplere de culoare): Se prevăd implicit șase culori. Pentru aplicarea altor culori, faceți 

dublu clic pe orice buton de umplere de culoare, sau apăsați butonul de setare alăturat, apoi selectați 

culoarea dorită din lista Color.  

 

Fill with Gradient (Umplere cu gradient): Se prevăd implicit șase gradienți. Pentru aplicarea altor gradienți, 

faceți dublu clic pe orice buton de umplere cu gradient, sau apăsați butonul de setare alăturat, apoi setați 

gradientul în Gradient Editor.  

Pentru a adăuga un nou gradient, apăsați dedesubtul barei gradientului pentru a defini limitele de culoare. 

Puteți selecta și o direcție a gradientului. 

 

 

Fill with Pattern (Umplere cu model): Se prevăd implicit șase modele. Pentru aplicarea altui model, faceți 

dublu clic pe orice buton de umplere model, sau apăsați butonul de setare alăturat, apoi stabiliți culoarea 

prim-planului și culoarea fundalului. 

 

 

Fill with Image (Umplere cu imagine): Faceți dublu clic pe butonul de umplere cu imagine, sau apăsați 

butonul de setare alăturat pentru a selecta un fișier de imagine pentru umplere. 

 Notă: pentru a șterge o limită intermediară de culoare, pur și simplu apăsați pe stop. 
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Clear the Fill Effect (Eliminare fect de umplere):  Apăsați butonul , apoi apăsați forma geometrică 

pentru a elimina efectul de umplere. 

 

3.3.8 Radiera 

Sunt oferite cinci metode de ștergere, inclusiv Normal Erasers (Radiere normale), Circle Eraser (Radieră 

circulară, Area Eraser (Radieră zonă), Object Eraser (Radieră obiect) și Erase All (Șterge tot).  

 

Normal Erasers : Normal Erasers sunt folosite pentru a șterge cerneala digitală 

creată de instrumentele Freehand Drawing. Există șase radiere normale de diferite forme și mărimi. 

Object Eraser : Selectați “Object Eraser” și apăsați pe un obiect pentru a-l șterge. 

Circle Eraser : Selectați “Circle Eraser” și trasați un cerc în jurul obiectului(lor) care trebuie șters(e). 

Area Eraser : Selectați “Area Eraser” și trasați un dreptunghi în jurul obiectului(lor) care trebuie șters(e). 

Erase All : Selectați “Erase All” și apăsați pe o pagină pentru a îndepărta toate obiectele din pagină. 

3.3.9 Textul  

Selectați  și apăsați unde doriți să înceapă textul pe pagină. Vor apărea bara de instrumente Text Box și 

Font. 
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3.3.9.1 Introducerea textului 

Puteți introduce text prin tastatura de pe ecran  sau Recunoaștere scris de mână . Puteți importa 

text din fișierul .txt în caseta de text. 

 

IQ Interactive Education Platform poate recunoaște scrisul de mână ca litere, numere sau simbol. Puteți 

apăsa  pe bara de instrumente Handwriting Recognition și selecta tipul de recunoaștere. 

 

 

                    

                                

3.3.9.2 Modificare format text 

Modifică formatul textului, inclusiv tip font, mărime font, bold, italic, underline, color și altele, prin bara de 

instrumente Font dacă este necesar. Puteți, de asemenea, adnota simbolurile fonetice pentru textul în 

engleză apăsând .  

 

3.3.9.3 Editare text 

Faceți clic dreapta pe textul selectat pentru copiere, tăiere, lipire, ștergere selectare tot sau anularea textului. 

 Notă: Dacă predați limba chineză în clasă, trebuie să schimbați interfața limbii în chineză, 

mai întâi. Procedați la fel pentru instrumentul Text apoi apăsați pe  pentru adnotarea 

simbolurilor fonetice (Pinyin) pentru textul în limba chineză. Totuși, trebuie să instalați Microsoft 

Pinyin IME 2003 pentru a activa această funcție. 

 

Backspace-Înapoi 
Enter Space-Spațiu 

Esc 
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3.3.10 Diagrama circulară și diagrama în batoane 

Selectați  sau , apoi apăsați în spațiul în care doriți să amplasați diagrama circulară sau diagrama în 

batoane pe ecran. 

 

În ferestrele de setare de mai sus, puteți seta denumirea (Name), valoarea (Value) și transparența 

(Transparency) pentru diagrame. 

Puteți seta și titlul (Title), efect 3D (3D Effect), culoare fundal (Background Color) și stilul (Style) pentru 

diagrama circulară și titlul (Title), axa (X) categoriei (Category (X) Axis), axa (Y) valorii (Value (Y) Axis), 

culoare fundal (Background Color), efect 3D (3D Effect) și stilul (Style) pentru diagrama în batoane. 

     

Pentru diagrama în batoane (Bar Chart), puteți modifica direct magnitudinea fiecărui baton; pentru Pie Chart, 

puteți modifica magnitudinea fiecărui sector și puteți separa unul sau mai multe sectoare de Pie Chart. Puteți 

autiliza, de asemenea, instrumentul Fill pentru modificarea culorii fiecărui baton sau sector. 

3.3.11 Editor de formule 

Editorul de formule vă permite să adăugați formule matematice complexe sau ecuații chimice pe pagina de 

tabel. 
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Selectați  și apăsați pe pagină, apoi va apărea fereastra Formula Editor. 

 

Introduceți formula în caseta de editare Formula Edit. 

 

 

 

 

Apăsați pe pagină și va apărea formula pe care o editați. 

 

 

3.4 Manipularea obiectelor 

3.4.1 Marquee Handles 

Instrumentele de editare utilizate frecvent vor fi prevăzute în Marquee Handles potrivit obiectului selectat. 

Puteți alege din aceste instrumente pentru a edita obiectul. 

 

 Notă: În sistemul Windows 7, puteți apăsa  în Formula Editor pentru activarea 

funcției Formula Recognition, care vă permite să introduceți formula prin scriere de mână. 
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3.4.2 Meniul butonului drept 

 

Copy , Cut , Paste , Clone: Puteți copia, tăia sau clona orice obiect pe o pagină și o puteți lipi pe 

aceeași pagină sau pe pagini diferite.  

Infinite Cloner (Clonare infinit): Puteți clona unul sau mai multe obiecte de câte ori doriți. 

 

Delete (Ștergere): Șterge unul sau mai multe obiecte selectate. 

Select All (Selectare tot): Selectați toate obiectele de pe pagină. 

Rotate Object (Rotire obiect): Atunci când este selectat un obiect, apare un dreptunghi de selecție în jurul 

obiectului. Puteți găsi un punct de rotire (Rotation Handle) deasupra dreptunghiului. Implicit, obiectul se 

rotește în jurul punctului central. Puteți defini un alt punct al bazei trăgând de punctul central.  
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Center (Centrare): Puteți afișa sau ascunde punctul central al obiectului. 

Resize Object (Redimensionare obiect): Puteți selecta unul sau mai multe obiecte și trage de punctul de 

redimensionare pentru a mări sau micșora dimensiunile. 

 

Move Object (Mutare obiect): Puteți muta obiectele în altă poziție pe aceeași pagină. Puteți, de asemenea, 

muta obiectele pe altă pagină. 

Pentru a muta obiectul în altă poziție pe aceeași pagină, selectați unul sau mai multe obiecte și trageți 

obiectul(ele) într-o nouă poziție pe pagină. 

 

Pentru a muta obiecte pe altă pagină, selectați unul sau mai multe obiecte, apoi trageți obiectul(ele) pe 

pictograma altei pagini pe fila paginii. 

 

Group Objects (Grupare obiecte): Puteți grupa mai multe obiecte laolaltă și manevra sau edita ca și cum 

ar fi un singur obiect. 
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Arrange Objects (Aranjare obiecte): Dacă obiectele se suprapun pe o pagină, puteți schimba ordinea de 

aranjare, inclusiv “Bring to Front”, “Send to Back”, “Bring Forward”, sau “Send Backward”. 

Align Objects (Aliniere obiecte): Puteți alinia obiectele selectate la partea de jos, de sus, stânga sau 

dreapta, sau central. 

Layout 

 

Identify Objects (Identificare obiecte): Puteți indentifica un obiect cu instrumentele de trasare ca text 

afișat pe pagină prin selectarea “indentified as” și puteți selecta și “tip identificare” așa cum doriți. 

   

 

Layout Objects (Mod de prezentare obiecte): Sunt disponibile Auto Layout și Customized Layout. 

Mirror Object (Oglindire obiect): Puteți obține rapid un obiect în oglindă selectând “Mirror Left”, “Mirror 

Right”, “Mirror Up” sau “Mirror Down”. 

Show/Hide Object (Arată/ascunde obiect): Puteți alege să afișați sau să ascundeți un obiect. 

Insert Annotation (Introducere adnotare): IQ Interactive Education Platform vă permite să adăugați 

propriile observații și adnotări unui obiect. Adnotările introduse pot fi re-editate sau eliminate. 

Flip Object (Rotire obiect): Puteți roti obiectul orizontal sau vertical. 

Insert Object to Background (Inserare obiect în fundal): Puteți insera unul sau mai multe obiecte 

selectate în fundal. Obiectul(ele) introdus(e) în fundal nu pot fi manevrate și editate. 

Save Object (Salvare obiect): Puteți salva unul sau mai multe obiecte ca fișiere imagine în 

format .bmp, .png, .gif, .jpg, .emf, .wmf sau .tif.  

Lock Object (Blocare obiect): Puteți bloca un obiect pentru a împiedica modificarea, mișcarea sau rotirea 

acestuia. De asemenea, il puteți debloca în orice moment. 

Add Hyperlink to Object (Adăugare hiperlink la obiect): Puteți crea hyperlink pe orice obiect de pe 

pagina tablei către o pagină web, sau un fișier din computer. 

 

1) Faceți clic dreapta pe obiectul selectat, apoi selectați “Hyperlink”, apare fereastra Hyperlink după cum 

urmează: 

Notă: Nu puteți grupa Label Tools, Function Tools, Math Tools, Pie Chart și Bar Chart. 
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2) Puteți crea hyperlink de la obiect către un fișier, pagină web, pagină a tablei, FTP sau website (de 

exemplu www.iqboard.net). 

3) Dacă doriți să adăugați efect de sunet la accesarea hyperlink-ului, puteți naviga și selecta un fișier de 

sunet local sau înregistrat pentru secțiunea Sound Effect.  

4) Puteți alege să deschideți link-ul apăsând pictograma din colț sau obiectul în sine. 

 

Review Operation (Revizuire operațiune): Atunci când generați și manevrați obiecte, IQ Interactive 

Education Platform înregistrează automat operațiunea și vă permite să le revizuiți oricând. 

Review Freehand Drawing (Revizuire schițare freehand): Puteți revizui ordinea schițării pentru obiectele 

create prin instrumente Freehand Drawing. Puteți alege “Loop” din pictograma setărilor pentru a revizui în 

mod repetat schițarea freehand. 

http://www.iqboard.net/
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Hot space: puteți seta obiectele de pe pagină ca „hot space”, clasificând și realizând corespondența dintre 

acest obiect și altele. 

 

1) Hot space: alegeți unul sau mai multe obiecte pentru setare hot space prin selectarea “set as hot space” 

în meniul butonului drept. 

2) Match: alegeți unul sau mai multe obiecte pentru a adăuga în „hot space” corespunzător în meniul 

butonului drept. 

 

3) Atunci când adăugați obiectul în „hot space”, dacă există corespondență, acesta va clipi, având culoarea 

verde, dacă nu, va clipi, având culoarea roșie, apoi va reveni. 
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Change Object Properties (Schimbare proprietăți obiect): Puteți selecta un obiect pe pagină și îi puteți 

schimba proprietățile. 

 

3.5 Operation Review (Revizuirea operațiunii) 

Atunci când creați și manevrați obiecte, IQ Interactive Education Platform înregistrează automat operațiunea 

și vă permite să o revizuiți oricând. 

 

Play/Pause (Redare/Pauză): redă sau pune pe pauză înregistrarea operațiunii din pagina tablei. Atunci 

când puneți pe pauză înregistrarea operațiunii, puteți face adnotări pe pagină.  

Stop (Oprire): Oprește redarea înregistrării operațiunii. 

Speed (Viteza): Setarea vitezei de redare. Cu cât mai mare este multiplicarea, cu atât mai mare va fi și 

viteza. 

Play Current Page Only (Redare doar pagina curentă): Redarea înregistrării operațiunii doar pe pagina 

curentă. 

Play from Current Page (Redare din pagina curentă): Redarea înregistrării operațiunii din pagina curentă 

în ultima pagină. 

Loop (Buclă): Repetă redarea atunci când este selectată. 

Toolbar Position (Poziție bară de unelte): Reglați poziția barei de unelte Operation Review. 
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3.6 Panoul de resurse 

Panoul Resource constă în 8 file, inclusiv Page, Subject Tools, Template, Resource Library, Search Tool, 

Local , Courseware Making și Interactive Response Panel. 

3.6.1 Pagina 

Fila Page oferă 2 moduri de previzualizare: modul List și modul Tile. Pentru redenumirea paginii, faceți dublu 

clic pe titlu sub pictograma paginii, apoi introduceți o denumire nouă. 

 

3.6.2 Instrumente după subiect 

În fila Subject Tools, puteți găsi numeroase instrumente interactive utile clasificate după subiect. Din meniul 

butonului drept, puteți șterge, redenumi, importa fișier sau folder, adăuga folder nou. Puteți trage obiectul 

direct într-un folder pentru a-l salva. 
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Pentru a adăuga un instrument după subiect pe pagină, puteți selecta pictograma unui instrument după 

subiect și apăsați pe pagină, apoi instrumentul va apărea pe pagină; puteți select, de asemenea, pictograma 

unui instrument după subiect și trageți un dreptungi pe pagina tablei, apoi instrumentul va apărea pe pagină. 

 

3.6.3 Template (Șablon) 

Fila Template oferă diverse șabloane în format cdf. Din meniul butonului drept, puteți șterge, crea un folder 

nou, importa fișier sau folder, exporta folder pentru șablon. 
 

Pentru a deschide un șablon, selectați pictograma șablonului pe care doriți să în inserați în tablă în zona de 

previzualizare, apoi apăsați pe pagină (puteți trage șablonul pe pagină), apoi șablonul relevant va fi introdus 

în pagina următoare. 

 

3.6.4 Resource Library (Arhiva de resurse) 

Fila Resource oferă o mare cantitate de imagini și resurse multimedia pe care le puteți utiliza în prezentare. 

Puteți salva un obiect creat în Resource Library.  

 

Există trei moduri de adăugare a unei imagini sau resurse multimedia în pagina tablei:  

1. Selectați o pictogramă a resursei și apăsați pe pagină, apoi resursa va fi introdusă în pagină; 

2. Selectați o pictogramă a resursei și trageți un dreptunghi pe pagina tablei, apoi resursa se va afișa potrivit 

dimensiunii dreptunghiului. Atunci când trageți obiectul, puteți apăsa tasta “Shift” pentru păstrarea raportului 

aspectului; 

3. Selectați o pictogramă a resursei și trageți pe pagină, apoi resursa va fi introdusă în pagină. 

Notă: Template are funcție de management utilizator. Pe lângă șabloanele implicite, 

fiecare utilizator poate vizualiza doar șabloanele salvate în contul său. 

Notă:  

1. Fila Subject Tools este accesibilă doar după înregistrarea numărului de ordine,, IQBoard, o 

cheie USB sau receptor IQClick A/B este conectat la computer. 

2. Puteți șterge și redenumi instrumentele sau folderele după subiect auto-adăugate. 
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Puteți realiza adnotări pe flash-ul sau clipul video introdus în pagină. Atunci când realizați adnotarea, fișierul 

flash sau video va staționa redarea; adnotarea va fi mutată în următorul layer atunci când fișierul flash sau 

video pornește.   

 

Pentru redarea resursei de fișier audio/video în pagină:  

Puteți seta redarea unui clip video sau capta o imagine din fișierul video și introduceți în pagină.  

Pentru setarea unui clip video, apăsați butonul “Video Clip”, atunci se va afișa o bară de cronometrare și 

lista. 

Trageți bara de cronometrare pentru a seta punctele de începere și terminare, apoi apăsați “Clip”, apoi 

fișierele video decupate vor fi adăugate în listă. Puteți redenumi sau șterge aceste fișiere video decupate din 

listă. Selectați un fișier video decupat și apăsați “Play” pentru a-l urmări. “Play in Order” este accesibil. 

 

 

Notă: Atunci când doriți să utilizați resurse de imagini în format .edf din folderul 

Favorite, doar prima și a treia metodă sunt accesibile. 
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3.6.5 Instrumentul de căutare (Search) 

Cu instrumentul Search, puteți traduce un cuvânt sau o propoziție în limba țintă, puteți căuta în dicționar și 

puteți căuta imagini pentru acesta. Vă permite, de asemenea, să introduceți rezultatele căutării în pagină.  

 

Translation/Dictionary (Traducere/Dicționar): Introduceți cuvântul sau propoziția pe care doriți să le 

traduceți sau să le căutați în dicționar și alegeți limba sursă și limba țintă, apoi apăsați “Search”. Puteți 

introduce rezultatele căutării în pagina curent apăsând “Insert to Current Page”. Rezultatul căutării introdus 

în pagină poate fi re-editat prin dublu clic pe acesta. 

 

Gallery (Galerie): Introduceți cuvântul pe care doriți să îl căutați și apăsați “Search”. Puteți selecta “Open 

from Webpage” pentru afișarea rezultatelor căutării într-o pagină web. Dacă doriți să introduceți o imagine în 

rezultatele căutării în pagină, puteți apăsa pe ea și o puteți trage în orice parte liberă a paginii. 

3.6.6 Local 

Fila Local vă permite să adăugați fișiere EDF, BMP, EMF, WMF, TIF, JPG, GIF, PNG, CDF, SWF, AVI, WMV, 

ASF, DAT, MPG, MPEG, RM, RMVB, MOV, VOB și FLV în computer în pagina tablei. Pentru un fișier într-un 

alt format, puteți face dublu-clic pe pictogramă pentru deschidere. 

 

Pentru a introduce un fișier în pagină ca obiect, selectați fișierul relevant din zona de previzualizare, apoi 

apăsați pe pagină sau trageți fișierul pe pagină. 

 

3.6.7 Panoul Courseware Making 

În panoul Courseware Making, puteți adăuga efecte de animație pentru obiecte și pagini și puteți introduce 

Notă: Pentru a imagine în format BMP, JPG, JPEG sau TIF, îi puteți ajusta transparența 

prin modificarea proprietăților. 

Notă:  

1. Puteți șterge și redenumi doar folderele auto-adăugate. 

2. Resource Library are funcție de management utilizator. Pe lângă resursele implicite, 

fiecare utilizator poate doar vizualiza resursele salvate în contul său. 
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întrebări în suportul de curs.  

 

3.6.7.1 Efect pe obiect 

Puteți seta efecte pentru orice obiect de pe pagină. 

 

Add Effect (Adăugare efect): Puteți adăuga patru tipuri de animație, “Entrance”, “Emphasis”, “Exit” și 

“Motion Paths”, pentru obiectul sau obiectele selectate pe pagina curentă. 

 

Pentru a adăuga efect pe un obiect, selectați unul sau mai multe obiecte și apăsați “Add Effect”, apoi 

selectați un tip de efect din meniul popup. 

 

 

După adăugarea efectelor, efectele se vor afișa în lista Effects potrivit ordinii.  

Notă: Atunci când adăugați efecte, puteți previzualiza efectele adăugate dacă bifați înainte 

“Auto Preview”. 
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Set Effect (Setare efect): Puteți personaliza efectele curent selectate. 

 

Puteți personaliza modul de redare a efectelor. Sistemul oferă trei moduri: “On Click” (implicit), “With 

Preview” și “After Preview”.  

 

Puteți personaliza viteza de redare a efectelor din meniul derulant. Puteți de asemenea regla viteza de 

redare crescând și scăzând lungimea timeline pentru un efect.  

 

Sistemul oferă numeroase tipuri diferite de timpi de repetare. 
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Sistemul vă oferă peste 20 tipuri de efecte de sunet. 

 

Meniul derulant al proprietății poate varia potrivit diferitelor efecte de animație. Puteți ajusta valoarea 

proprietății pentru a schimba efectul redării. 

 

Edit Effect (Editare efect): Puteți schimba efectele de animație și puteți ajusta ordinea redării. 

 

Pentru modificarea unui efect, selectați obiectul pe care doriți să îl modificați și apăsați “Change”, apoi 

selectați efectele de animație corespunzătoare din meniul derulant. 

 

Pentru a schimba ordinea de redare, selectați obiectul din lista Animation Object, apoi apăsați “Move up” 

sau “Move down” . 
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Remove Effect (Eliminare efect): Puteți îndepărta efectele de pe obiect de care nu aveți nevoie din lista 

Animation Object. Selectați obiectul animat pe care doriți să îl eliminați, apoi apăsați “Remove”. 

 
Auto Preview (Previzualizare automată): Puteți previzualiza efectele pe obiectul selectat. Selectați 

obiectul pe care doriți să realziați previzualizarea, apoi apăsați “Current Preview”. După ce efectul 

previzualizării este finalizat, software-ul va opri automat previzualizarea. 

Playing Preview (Redare previzualizare): Această funcție vă permite să previzualizați toate efectele pe 

obiect din pagina curentă.  

3.6.7.2 Efect pe pagină 

Add Page Effect (Adăugare efect pagină): Pentru a adăuga efecte pe o pagină, apăsați “Page” și selectați 

efectul relevant din meniul derulant.  

 

După adăugarea efectelor, efectele se vor afișa în lista Effects potrivit ordinii și va apărea o pictogramă mică 

în colțul din stânga sus al pictogramei paginii.  

Notă: 

1. Atunci când obiectul este îndepărtat, toate efectele adăugate pe acesta vor fi șterse automat.  

2. Puteți îndepărta numeroase obiecte animate în același timp apăsând tasta “Shift”. 

  



Returnstar Interactive Technology Group Co., Ltd. 

 

 58 

 

Apăsați “Apply to All Pages”, apoi tot restul paginilor vor împărți aceleași efecte cu cea curentă. 

 

Customize Page Effect (Personalizare efect de pagină): Puteți personaliza efectele paginii, inclusiv 

viteza de redare și sunetul.  

 

Selectați efectul paginii pe care doriți să îl personalizați, apoi selectați viteza dorită din lista Speed. Puteți 

regla, de asemenea, viteza de redare crescând și reducând lungimea timeline pentru un efect.  

 

Puteți selecta efectul de sunet dorit din lista Sound. 

 

Change Page Effect (Schimbare efect de pagină): Puteți schimba efectele paginii conform nevoilor 

propriu-zise. Apăsați “Change” și selectați efectul paginii pe care doriți să îl schimbați, apoi alegeți un efect 

de pagină dorit. 

Delete Page Effect (Ștergere efect de pagină): Puteți șterge orice efect de pagină doriți. Selectați efectul 

paginii pe care doriți să îl ștergeți, apoi apăsați “Remove”. 
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3.6.7.3 Adăugare chestionar interactiv 

IQ Interactive Education Platform prevede șase tipuri de întrebări, inclusiv variantă unică de răspuns 

(Monomial Choice), variantă multiplă de răspuns (Multiple Choice), adevărat sau fals (True or False), 

completare de spații libere (Gap Filling) și sortare în ordine (Sort in Order), care vă pot ajuta să treziți 

interesul cursanților în măsură mai mare. 

 

Apăsați pictograma tipului de întrebare pe care doriți să o introduceți în panoul Question Setting și apăsați 

“Insert”, apoi tipul întrebării pe care o selectați va fi afișat pe pagina curentă. 

 

Edit Question (Editare întrebare): Puteți edita întrebările interactive pe care le introduceți. 

Pentru activarea casetei de text Title sau Option, puteți faceți dublu clic pe caseta de text, sau apăsați “Insert 

Text” și caseta de text în consecință, sau selectați caseta de text și apăsați  în Marquee Handles. 

Notă: Puteți, de asemenea, îndepărta efectele de pagină prin ștergerea paginii. Pentru a 

șterge mai multe efecte de animație în același timp, apăsați tasta “Shift” și selectați-le una după 

alta. 
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Editați întrebarea din caseta de text. Pentru editarea casetei de text, apăsați pur și simplu partea albă a 

paginii. Puteți trage titlul sau caseta de text a opțiunii pentru schimbarea poziției. 

 

Customize Question (Personalizare întrebare): Puteți schimba proprietățile întrebării. 

 
Response Settings (Setări răspuns): Puteți adăuga link și sunet pentru răspunsurile corecte și greșite. 

Notă: În Gap Filling, puteți stabili unul sau mai multe răspunsuri corecte pentru o întrebare. Fiecare linie reprezintă 

un răspuns corect (de exemplu, _+_=2, răspunsul poate fi 1,1; 0,2; 2,0.). Consultați exemplul de imagine de mai sus. 
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Courseware Information (Informații suport de curs): Puteți verifica totalul întrebărilor, totalul punctelor, totalul 

încercărilor și numărul întrebărilor fără răspunsuri aici. 

 
 

Apăsați “exam” pe panou pentru a verifica răspunsul tuturor întrebărilor și setările de scor din actualul suport de 

curs.  
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3.7 Instrumente de asistare (Assistant Tools) 

3.7.1 Instrumente ecran (Screen Tools) 

IQ Interactive Education Platform vă oferă tipuri de instrumente de ecran, inclusiv Spotlight, Reveal Screen, 

Screen Arrow, Highlight și Black Screen. Puteți selecta aceste instrumente din bara de meniu „Tools”, bara 

Assistant Tools sau bara de instrumente mobilă. De asemenea, puteți utiliza instrumente de trasare pentru a face 

adnotări atunci când folosiți aceste instrumente de ecran. 

Spotlight (Spot luminos) : Puteți trage marginea pentru a face zoom și muta Spotlight. Se poate utiliza 

layer-ul inferior al zonei evidențiate. Puteți apăsa  în partea dreaptă jos pe ecran pentru ajustarea 

proprietăților Spotlight. 

 

Reveal Screen (Afișare ecran): Sunt prevăzute trei metode de afișare: sus-jos, stânga-dreapta, toate 

direcțiile. Se poate utiliza zona neacoperită. Puteți apăsa  în partea dreaptă jos pe ecran pentru 

ajustarea proprietăților funcției Reveal Screen. 
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Screen Arrow (Săgeată ecran): Puteți plasa o săgeată mare pe ecranul interactiv pentru a atrage atenția 

asupra zonei ecranului. Faceți clic dreapta pe săgeată, puteți schimba culoarea fundalului, direcția și 

transparența săgeții. 

 

Black Screen (Ecran negru): Puteți afișa un fundal de ecran negru, cum ar fi culoare, imagine, mesaj de 

instrucțiuni, pentru a atrage atenția sau indicarea următorului pas în instruire. Puteți seta timpul pentru 

ecranul negru. Pentru a selecta Black Screen înainte de expirarea timpului, apăsați “Ctrl+Alt+E”.  

 

Highlight (Evidențiere): Puteți apăsa  în partea dreaptă jos a ecranului pentru ajustarea proprietăților 

Highlight, cum ar fi culoarea fundalului și transparența. Și puteți selecta Single Spotlight sau Multi Spotlights 

pentru a evidenția una sau mai multe zone de atenție. 
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3.7.2 Instrumente etichetare (Label Tools) 

IQ Interactive Education Platform vă oferă tipuri de instrumente de etichetare, inclusiv Dimension Label, Angle 

Label, Dividers, Ruler, Protractor, Isosceles Right Triangle și 30°Right Triangle. Puteți selecta Lable Tools prin 

selectarea  din bara de meniu “Tools”, bara Assistant Tools sau bara de instrumente mobilă. 

 

Dimension Label (Etichetă dimensiune): Realizați o etichetă de dimensiune (Dimension Label) pentru 

adnotarea distanței dintre două puncte. Pentru adăugarea unei etichete de dimensiune (Dimension Label) pe 

pagină, mutați cursorul pe pagină, determinați punctul de pornire a dimensiunii și apăsați, apoi mutați 

cursorul în alt punct pe pagină și apăsați. Aceste două puncte vor fi conectate automat, iar lungimea va fi 

afișată. 

 

Angle Label (Etichetă unghi): Puteți utiliza instrumentul Angle Label pentru măsurarea unui unghi și 

modificați din nou amplitudinea unghiului. Pentru adăugarea unui Angle Label pe pagină, mutați cursorul pe 

pagină și apăsați pentru a determina vertexul, apăsați din nou pentru a determina o latură a unghiului, apoi 

mutați cursorul, se va afișa pe pagină unghiul relevant. 
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Dividers (Divizori): Puteți utiliza instrumentul Dividers pentru a trasa un arc de cerc sau un sector. 

 

Pentru mutarea divizorilor, apăsați brațul stâng sau drept al divizorilor și țineți apăsat pentru a muta divizorii 

pentru schimbarea poziției; 

 

Pentru schimbarea razei, apăsați brațul drept al divizorilor și țineți apăsat pentru a muta orizontal la stânga 

sau la dreapta, apoi lungimea razei se va schimba și va fi afișată pe divizori; 

 

Pentru a trasa un arc de cerc sau un sector, apăsați și țineți apăsat instrumentul de trasare pe divizori, apoi 

rotiți pentru trasare.  

 

Puteți modifica proprietățile din meniul butonului drept, cum ar fi culoare, transparență, cifre zecimale, unități 

(există cm, mm, pix, inci în lista derulantă; puteți tasta manual o unitate de care aveți nevoie),  

Ruler (Riglă): Puteți utiliza Ruler pentru măsurarea obiectelor și trasați o linie de orice dimensiune 

particulară (10 cm implicit; aptă de extindere la infinit). Pentru adăugarea unei rigle pe pagină, mutați 

cursorul pe pagină, determinați poziția riglei și apăsați, apoi rigla se va afișa pe pagina tablei. 

 

Puteți utiliza, de asemenea, instrumentele Freehand Drawing sau instrumentul Line pentru trasarea unei linii 

drepte de o anumită lungime în lungul scalelor riglei. Atunci când este rotită rigla, unghiul curent de rotație 

este afișat în centrul riglei. 

 

Protractor (Raportor): Puteți adăuga un raportor pe pagina tablei. Puteți utiliza raportorul pentru a măsura 

unghiul și trasa arce de cerc cu un anumit unghi. Pentru adăugarea unui raportor pe pagină, mutați cursorul 

pe pagină, determinați poziția raportorului și apăsați, apoi se va afișa pe pagină raportorul. 

 Notă: Gradul afișat al Angle Label este gradul creat de rotirea celei de-a doua laturi 

în sens invers acelor de ceasornic față de prima. 

Brațul drept 
Brațul stâng 

Partea superioară 

Instrument de trasare 

Afișare lungimea razei 



Returnstar Interactive Technology Group Co., Ltd. 

 

 66 

 

Puteți selecta și Arc, Solid Sector sau Hollow Sector din meniul butonului drept, apoi folosiți instrumentele 

Freehand Drawing sau instrumentul Line pentru a trasa forma selectată de-a lungul scalei raportorului. 

 

Right Triangle (Triunghi dreptunghic): Sunt prevăzute două instrumente Right Triangle, Isosceles Right 

Triangle și 30° Right Triangle. Pentru a adăuga un triunghi dreptunghic (Right Triangle) pe pagină, mutați 

cursorul pe pagină, determinați poziția triunghiului dreptunghic și apăsați, apoi se va afișa triunghiul 

dreptunghic pe pagină. 

 

       Triunghi dreptunghic isoscel Triunghi dreptunghic cu unghi de 30° 

 

Puteți utiliza instrumentele Freehand Drawing și instrumentul Line pentru a trasa o linie dreaptă de-a lungul 

scalelor triunghiului dreptunghic. Atunci când rotiți triunghiul dreptunghic, unghiul curent de rotație se va 

afișa în centrul triunghiului dreptunghic. 

3.7.3 Captura ecranului (Screen capture) 

Pentru accesarea funcției Screen Capture, puteți apăsa “Tools” în bara de meniu, sau apăsați  în bara de 

instrumente Assistant Tools, sau apăsați  în bara de instrumente mobilă. 
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Pentru o captură a ecranului complet: apăsați “Full Screen Capture ” pentru captura întregului ecran. 

Pentru o captură ferestrei pe ecran: apăsați butonul “Window Capture ” pe bara de instrumente, selectați 

fereastra pe care doriți să o captați și apăsați fereastra. 

Pentru o captură a zonei dreptunghiulare a ecranului: apăsați “Area Capture ”, apoi apăsați și trageți 

cursorul pentru a defini zona dreptunghiulară pe care doriți să o captați; 

Pentru o captură a zonei freehand: apăsați “Freehand Capture ”, apoi apăsați și trageți cursorul pentru 

definirea liberă a zonei pe care doriți să o captați. 

Puteți apăsa și  pentru a selecta metoda de introducere a capturii ecranului. Sunt accesibile “Insert to 

current page” și “Insert to new page”. 

 

 

3.7.4 Înregistrarea și redarea ecranului (Screen Record and Playing) 

Pentru funcția Screen Record, puteți apăsa “Tools” în bara de meniu, sau apăsați  în bara de 

instrumente Assistant Tools, sau apăsați  în bara de instrumente mobilă. 

Screen Record (Înregistrare ecran): Pentru o înregistrare a ecranului, selectați stilul de înregistrare dorit 

din “Options”. Se poate ajusta și calitatea clipului video. 

 

 

Apăsați , apare o fereastră Prompt, apăsați “OK”, atunci apare o fereastră de salvare a fișierului. 

Determinați denumirea și calea fișierului, apoi apăsați “Save” pentru a începe înregistrarea. 
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În timpul înregistrării, puteți apăsa  pentru a staționa înregistrarea și puteți apăsa  pentru finalizarea 

înregistrării. 

Video Player (Player video) :  

 

Convertor: Puteți converti fișierul avi înregistrat în format swf, wmv, flv și exe. 

 

3.7.5 Instrumente speciale (Special Tools) 

IQ Interactive Education Platform oferă și instrumente utile, inclusiv Dice, Calculator, Magnifier, Tickertape 

Scrolling, Clock și On–Screen Keyboard, Layer Perspective, Video Capture și Audio Record.  

Notă：Puteți salva calea implicită a clipului video din “Options > Save Path > Default Path”. 
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Pentru accesarea instrumentelor Special Tools, puteți apăsa “Tools” în bara de meniu, sau apăsați  în 

bara de meniu Assistant Tools, sau apăsați  în bara de instrumente mobilă. 

 

Dice (Zaruri) : Puteți utiliza Dice pentru a genera 1-7 numere aleatorii. Și puteți apăsa “Parameter 

setting” pentru a seta valoarea maximă și cantitatea numerică. 

 

Calculator (Calculator) : IQ Interactive Education Platform poate apela calculatorul din sistemul de 

operare. 

Magnifier (Lupă) :Lupa poate focaliza ușor pe anumite zone ale ecranului. Din meniul butonului drept 

puteți modifica proprietățile lupei (Magnifier Properties), cum ar fi forma lupei, scala, dimensiunea ferestrei 

etc.  

Tickertape (Bandă) : Puteți crea banda cu derulare pe ecran pentru afișarea mesajului. 

Apare fereastra Tickertape Settings după cum urmează, puteți schimba proprietățile, dacă este necesar: 

 

Clock and Timer (Ceas și temporizator) : Instrumentul Clock vă permite să afișați un ceas sau un 

temporizator pe ecran. Puteți personaliza Clock apăsând pictograma . 
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On-screen Keyboard (Tastatura ecranului) : IQ Interactive Education Platform poate apela tastatura 

de pe ecran din sistemul de operare. 

Layer Perspective (Perspectiva layer-ului) : Cu Layer Perspective, perspectiva layer-elor de obiecte 

multiple și se poate obține afișarea obiectului sau imaginii de mai jos. 

Pentru utilizarea Layer Perspective, mutați pe layer-ele suprapuse. 

 

Implicit, numărul de layer-e de perspectivă este de unul; dar puteți face clic dreapta pe instrument sau 

apăsați  dreapta sus pentru a seta layer-ele de formă, transparență și perspectivă. 

 

Video Capture (Captură video): Cu Video Capture, camera de conectare sau clipul video DV se poate 

afișa. Și puteți captura clipul video pe pagina tablei.  

 

Pentru utilizarea Video Capture, apăsați  pe fereastra Video Capture, camera de conectare sau video DV 

se va afișa pe software. Și puteți apăsa  pentru a seta rezoluția clipului video. 



Returnstar Interactive Technology Group Co., Ltd. 

 

 71 

 

Puteți apăsa, de asemenea  seta să introduceți clipul video capturat la pagina curentă sau la pagina 

nouă, apoi apăsați  pentru a porni captura. 

 

Audio Record (Înregistrare audio): puteți înregistra clipul audio și reda prin introducerea fișierelor audio în 

pagină.  

 

Puteți apăsa, de asemenea, pictograma de înregistrare audio pentru înregistrarea audio în bară, apăsați din 

nou pentru oprire, iar fișierul audio înregistrat va conecta obiectul automat. 

 

Notă：Dacă există mai multe camera și clipuri video DV care se conectează la 

computer în același timp, puteți schimba sursa video. 
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3.7.6 Tastă de asistent (One-key Wizard) 

Apăsați  în bara de instrumente mobilă pentru închiderea ferestrei curente. 

Apăsați  în bara de instrumente mobilă pentru minimizarea ferestrei curente. 

 

3.7.7 Acces rapid la aplicațiile utilizate frecvent (Frequently Used Applications) 

Cu Frequently Used Applications, puteți obține accesul rapid la orice program și fișier extern. 

Pentru accesarea Frenquently Used Applications, apăsați “Frequently Used Applications” în bara de meniu, 

sau apăsați  în bara de instrumente Assistant Tools, sau apăsați  în bara de instrumente mobilă, și 

apare bara de instrumente Application (afișează implicit IE Program). 

 

Apoi apăsați pictograma unei scurtături în bara de meniu pentru a deschide direct programul extern sau 

fișierul. Între timp, puteți apăsa  pentru a adăuga sau șterge orice aplicație. 

3.7.8 Fereastra încorporată (Embedded window)  

Cu Embedded Window , puteți încorpora documente office (doc, xls, ppt, docx, xlsx și pptx）în pagina 

tablei și le puteți edita, de asemenea. 

 
Pentru a adăuga o fereastră încorporată (Embedded Window) pe pagină, selectați “Embedded Window” în 

bara de meniu, sau apăsați  în bara de instrumente Assistant Tools, sau apăsați  în bara de 

instrumente mobilă; apoi mutați cursorul în poziția pe care doriți să o încorporați și apăsați o singură dată. 

Apare fereastra Open, după cum urmează:  

 

Notă: Implicit, aceste două pictograme nu sunt în bara de instrumente Floating Tools, puteți 

personaliza bara de instrumente Floating Tools în System Settings>Toolbar din bara de meniu. 
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Puteți selecta un fișier sau o pagină web pe care doriți să le deschideți, apoi apăsați “OK”, fișierul sau pagina 

web selectate vor fi încorporate în pagina tablei. 

 

 

Apăsați pictogramele de la partea inferioară pentru operațiunea corespunzătoare: 

Open 

(Deschidere)  

Pentru a redechide fișierul sau pagina web pe care doriți să o 

încorporați. 

Read 

(Citire)  

Pentru citirea fișierului sau pagina web deschisă. 

Play 

(Redare)  

Pentru redarea fișierului deschis. 

Pause 

(Pauză)  

Pentru staționarea redării curente. 

Stop 

(Oprire)  

Pentru oprirea redării curente. 

Save 

(Salvare)  

Pentru salvarea word și excel revizuite de utilizatorul curent. 

Zoom in 

(Mărire)  

Pentru focalizarea pe documentul sau pagina web office 

deschisă. 

 

Zoom out 

(Micșorare)  

Pentru mărirea documentului office sau paginii web deschise. 

 

Maximize 

(Maximizare)  

Pentru Maximizarea ferestrei. 

Restore 

(Restabilire)  

Pentru restabilirea ferestrei maximizate la cea inițială. 

Close 

(Închidere)  

Pentru închiderea ferestrei încorporate și se va afișa pe pagina 

tablei ca obiect. 

 

 

3.7.9 Instrumentul Shade Tool 

Cu Shade Tool, puteți nuanța conținutul de pe pagina tablei. Uneori, este util în instrumente sau demo. 

 Notă: Pentru windows XP, este necesară actualizarea pe IE7 pentru mărirea/micșorarea pagina web. 
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Pentru adăugarea Shade Tool pe pagină, selectați “Shade Tool” în bara de meniu, sau apăsați  în bara 

de instrumente Assistant Tools, sau apăsați  în bara de instrumente mobilă.  

Pentru a trage un dretunghi pentru nuanțarea conținutului pe pagina tablei, puteți modifica dimensiunea 

nuanțării apăsând dreptunghiul și ținând apăsat și mutați sau apăsați butonul de tragere  în colțul din 

dreapta jos și ținând apăsat pentru a muta. 

 

Faceți clic dreapta pe intrumentul Shade Tool, puteți seta efectul de afișare prin selectarea “Reveal” sau 

“Fill” sau “Full Screen”. Puteți, de asemenea, realiza adnotarea pe zona de fundal a instrumentului Shade 

Tool apăsând “Annotation”. Apăsați “Clean Annotation” pentru a elimina adnotarea. Dacă închideți Shade 

Tool fără selectarea “Clean Annotation” sau “Reset to Default”, adnotarea va fi afișată data următoare atunci 

când utilizați instrumentul Shade Tool. 

    

 

Pentru închiderea instrumentului Shade Tool, puteți face dublu clic pe acesta sau selectați “Close” în meniul 

butonului drept. 

 

3.7.10 Text to Speech (Redare vocală text) 

Cu instrumentul Text to Speech, textul de pe pagina tablei poate fi citit cu voce tare. 

Pentru utilizarea instrumentului Text to Speech, selectați “Text to Speech” în bara de meniu, sau apăsați  

Notă：Instrumentul de nuanțare nu poate nuanța ferestrele suspendate inclusiv video, 

flash, embedded window și imagine dinamică gif. 
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în bara de instrumente Assistant Tools, sau apăsați  în bara de instrumente mobilă.  

 

Mutați cursorul pe textul pentru care doriți citirea și apăsați pe text, va începe citirea textului. Implicit, textul 

este citit în limba chineză. Puteți apăsa  pe bara de setări de mai sus pentru a modifica din limba 

chineză în limba engleză. Puteți ajusta viteza  și volumul  pentru citire. 

 

3.8 Video-conferința (Video conference) 

Video-conferința poate aduce împreună oameni din locuri diferite pentru o întrunire. Cu această funcție, se 

pot obține tot felul de caracteristici interactive în timp real, cum ar fi conversații video, partajarea ecranului, 

intercomunicații de voce și text chat. 

 

3.8.1 Crearea unei conferințe (Create a Conference) 

Pentru crearea unei conferințe: 

Selectați “Video Conference > Create Conference” în bara de meniu, apoi va apărea o fereastră 

Conference. 

 

Puteți modifica denumirea dacă este necesar și dacă aveți numeroase IP-uri, puteți selecta un IP prin caseta 

de introducere a adresei IP. Apăsați “OK”. Video-conferința este creată. 

Notă：Această funcție este disponibilă doar atunci când o tablă interactivă IQBoard sau un 

adaptor USB sunt conectate. 

 

Notă：Utilizatorul poate descărca și instala altă bază de date de voce TTS de pe internet. 

După instalare, limba instalată va fi adăugată în lista Setting . 
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3.8.2 Participarea la o conferință (Join a Conference) 

Pentru alăturarea într-o conferință creată, selectați “Video Conference > Join Conference” în bara de meniu, 

apoi va apărea fereastra Join Conference.  

 

Apăsați butonul “Options” în fereastra Join Conference și setați IP-ul local, dispozitivul de intrare audio și 

dispozitivul video. Apăsați “OK”, acum puteți accesa fereastra conferinței pentru a participa. 

 

3.8.3 Pe durata conferinței 

Ascunde/afișează fereastra video a oricărui participant (Hide/Show The Video Window of Any 

Participant): După alăturarea într-o conferință, fereastra video locală și fereastra video a prezentatorului 

conferinței sunt afișate automat pe desktop. Puteți ascunde și afișa fereastra video a oricărui participant 

apăsând  lângă numele participantului. 
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Partajare desktop participanți (Share Desktops of Participants): Participanții pot partaja desktop-urile 

între ei, apăsând . Participanții pot utiliza această funcție doar după confirmarea prezentatorului.  

Activare/dezactivare microfon și difuzor (Enable/Disable Microphone and Speaker): Puteți bifa  și 

 sau nu să activați sau să dezactivați microfonul și difuzorul. Puteți utiliza și cursoarele de lângă pentru 

reglarea volumului microfonului și difuzorului. 

În plus, puteți activa și dezactiva microfonul și difuzorul apăsând  lângă numele participantului în tab-ul 

User. 

Trimitere mesaj către alți participanți (Send Message to Other Participants): Orice participant poate 

trimite mesaje altora. Selectați tab-ul “Chat” sau apăsați butonul  și introduceți mesajul în caseta de text, 

apoi apăsați  pentru a trimite mesajul.  

 

3.8.4 Părăsirea unei conferințe 

Orice participant poate apăsa  din drepata sus a ferestrei Video Conference pentru a părăsi conferința; 

Prezentatorul unei conferințe poate forța un participant să părăsească conferința apăsând  lângă numele 

participantului în tab-ul User. 

3.9 Setările sistemului (System Settings) 

Panoul System Settings vă permite să modificați proprietățile implicite ale instrumentelor Drawing Tools, 

Toolbars, Quick access, Operating setting și alte setări. 

 

Pentru a deschide panoul System Settings, puteți apăsa “System Settings” în bara de meniu; sau apăsați 

pictograma barei de sarcini IQ Interactive Education Platform în colțul din dreapta jos, apoi selectați “System 

Settings”.  

 

Reset to Dafault (Resetare la valoare implicită): Restabilește toate setările sistemului la setările din 

fabrică. 

 

Export Configuration (Configurare export): După finalizarea tuturor setărilor, puteți exporta setarea și o 
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puteți salva ca fișier de configurare pentru utilizare ulterioară. 

 

Import Configuration (Configurare import): Puteți importa fișierul de configurare salvat înainte. 

 

Freehand Drawing Tool Properties (proprietăți instrumente Freehand Drawing): Puteți schimba 

proprietățile implicite ale instrumentelor Drawing Tools, cum ar fi culoare, grosime, transparență. 

 

Toolbar Settings (Setările barei de instrumente): Puteți personaliza pictogramele în bara de instrumente 

Drawing Tools, bara de instrumente Common Tools, bara de instrumente Assistant Tools, bara de 

instrumente mobilă, panoul Resources și Subject Tools. 
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Quick Access Settings (Setări acces rapid): Puteți adăuga cel mult 20 aplicații în sistemul de operare din 

scurtăturile de aplicație (Application Shortcuts). Tool Shortcut este pentru taste scurte pe tabla interactivă 

IQBoard. Cel mult 8 instrumente se pot adăuga în Tool Shortcut. 

 
 

Operating Settings (Setări de operare): Apăsând “Operating Setting” în panoul System Settings, puteți 

accesa Save Setting, Page Background Setting, Symbol Setting și Auto Group Setting. 



Returnstar Interactive Technology Group Co., Ltd. 

 

 80 

 

 

Pentru salvarea setărilor, dacă alegeți “Save Inserted File as Duplicate”, fișierul introdus cum ar fi video, 

Flash, și fișierele deschise în fereastra încorporată vor fi salvate ca duplicat în lista resurselor cdf sau cdp; 

Dacă alegeți “Save Inserted File as Shortcut”, fișierul introdus cum ar fi video, Flash, și fișierele deschise în 

fereastra încorporată vor fi salvate prin memorarea locației fișierelor. 

 

Cu funcția Set Default, puteți, de asemenea, seta culoarea implicită a fundalului și imaginea implicită a 

fundalului. 

Cu funcția Symbol, puteți seta culoarea implicită a cadrului și culoarea implicită de umplere a simbolului. 

 

Dacă activați Auto Group Settings, atuncicând desenați sau scrieți pe un ecran interactiv cu instrumente 

Freehand Drawing (inclusiv pencil, pen, brush pen, washing brush și creative pen), IQ Interactive Education 

Platform va grupa automat obiectele pe care le creați în imediata vecinătate, permițându-vă să interacționați 

cu aceste obiecte ca și cu unul singur. Există două setări pentru această funcție: Time Interval (durata dintre 

crearea a două obiecte diferite) și Distance (spațiul dintre două obiecte diferite). 

 

Alte setări 1: Apăsând “Alte setări 1” pe panoul System Settings, puteți realiza setările pentru limbă și 

securitate. 
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Security Settings (Setări securitate): puteți schimba parolele contului curent de utilizator. 

Laguage Settings (Setări limbă): puteți schimba limba interfeței software alegând dintre chineză 

simplificată (Simplified Chinese), engleză (English) și chineză tradițională (Traditional Chinese). 

 

Alte setări 2 (Other Settings 2): puteți face alte setări, după cum urmează 
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Partea III Ghidul de utilizare IQClick 

Capitolul 1 Instalarea și dezinstalarea hardware-ului 

1.1 Configurarea standard  

1 Receptor; 

1 Teacher IQClick; 

24/32/64 Student IQClicks (suport personalizat); 

1 CD de instalare (inclusiv IQ Interactive Education Platform și ghid de utilizare). 

1.2 Specificații 

IQClick Seria A 

Receptor 

 

Descrierea caracteristicii Primește semnal de la IQClicks și îl transferă către PC. 

Dimensiune (mm) 732614 

Temperatura de lucru 0-40 °C 

Umiditatea de lucru 0-90% 

Sursa de alimentare USB (5V) 

Unghi efectiv 360°(100 m fără obstacole) 

Indicator Indicatorul se aprinde atunci când primește semnal. 

 Teacher IQClick 

 

Descrierea 

caracteristicii 

Teacher IQClick este utilizat 

pentru controlul procesului de 

predare, pornirea răspunsurilor 

și examinării interactive și 

obținerea feedback-ului și 

raportului de activitate. 

Dimensiune (mm) 1305122 

Temperatura de lucru 0-40°C 

Umiditatea de lucru 0-90% 

Sursa de alimentare 
2 baterii AAA  

Notă: dacă pictograma bateriei 
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clipește  

În colțul din dreapta sus pe LCD,  

Indică nivel scăzut al bateriei. 

(Înlocuiți bateriile în timp utuil 

pentru a asigura funcționarea 

normală). 

Unghi efectiv 360° 

Distanța 100m fără obstacole 

Pornire: Apăsați  o dată pentru a porni IQClick; 

Taste de comandă: 

Pe durata răspunsului interactiv sau a examinării interactive, puteți schimba întrebările și 

porniți /puneți pauză/opriți activitatea. 

Apăsați OK pentru a confirma o selecție în software; trimiteți răspunsuri în LCD către 

Receptor. 

Opțiunea Enter: 

Opțiuni implicite pentru introducere, puteți accesa A、B、C、D、E、F、Yes、No și puteți, 

de asemenea, utiliza F1, F2 pentru a afișa fereastra de rezultate, fereastra clasamentului, 

Black Screen și modurile de schimbare în software. 

În modul de input digital, apăsați (Fn+  ) mutați în modul de input opțiune. 

Enter digital: apăsați (Fn+  ) schimbați în modul de input digital. 

Oprire: apăsați și țineți apăsat timp de 3 secunde pentru a opri IQClick. (IQClick se 

va opri automat dacă staționează timp de 20 minute. ) 

Student IQClick 

 

Descrierea 

caracteristicii 

Student IQClick este prevăzut 

ca toți cursanții să poată lua 

parte la răspunsurile interactive 

și la examinarea interactivă. 

Dimensiune (mm) 1305122 

Temperatura de lucru 0-40°C 

Umiditatea de lucru 0-90% 

Sursa de alimentare 

2 baterii AAA  

Notă: dacă pictograma bateriei  

clipește la partea dreaptă sus a 

LCD-ului, indică  
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nivel scăzut al bateriei. 

(Înlocuiți în timp util  

bateriile, pentru a asigura 

funcționarea normală.  

Unghi efectiv 360° 

Distanța 100m fără obstacole 

Mod Interactive Response și Interactive Exam 

Pornire: Apăsați  o dată pentru a porni IQClick; 

Taste de comandă: puteți trimite răspunsuri, lua parte la răspunsurile anticipative în 

Interactive Response și schimba întrebările. 

Opțiunea Enter: 

Opțiuni implicite pentru introducere, puteți accesa A、B、C、D、E、F、Yes、No și puteți 

utiliza, de asemenea, F1,F2 pentru a afișa fereastra de rezultate, fereastra de clasament, 

Black Screen și puteți schimba modurile în software. 

În modul input digital,apăsați (Fn+   ) și schimbați în mod input opțiune. 

Enter Digital: apăsați (Fn+  ) și schimbați în mod input digital. 

Combinație de taste 

Fn + : schimbați în mod input digital. 

Fn + : Schimbați în mod input opțiune.  

Fn+ : trimite mesaj cu întrebarea 

Fn+ : După activitate, arată rezultatul întrebării curente în LCD. 

De ex 

întrebare: 1+1=? 

Când ați șters de pe LCD după trimitere răspunsul „2”. 

Apăsați ( Fn+  ), serverul va returna răspunsul „2” pe LCD-ul dvs.  

Fn+2: apăsați o dată această tastă, apoi introduceți numărul întrebării la care doriți să 

treceți și apăsați OK pentru a omite întrebarea. 

Oprire: apăsați și țineți apăsat  timp de 3 secunde pentru a opri IQClick. (IQClick se 

va opri automat dacă staționează timp de 20 minute).  
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IQClick Seria B 

Receptor 

 

Descrierea 

caracteristicii 
Primește semnal de la IQClicks și îl transferă către PC. 

Dimensiune (mm) 732614 

Temperatura de 

lucru 
0-40°C 

Umiditatea de lucru 0-90% 

Sursa de alimentare USB (5V) 

Unghi efectiv 360°(100m fără obstacole) 

Indicator Indicatorul se aprinde atunci când primește semnal. 

 

Teacher IQClick 

              

Descrierea 

caracteristicii 

Teacher IQClick este utilizat pentru 

controlul procesului de predare, 

pornirea răspunsurilor și examinării 

interactive și obținerea 

feedback-ului și raportului de 

activitate. 

Dimensiune (mm) 1004922 

Temperatura de 

lucru 
0-40°C 

Umiditatea de lucru 0-90% 

Sursa de alimentare 2 baterii AAA 

Unghi efectiv 360° 

Distanța 100m fără obstacole 
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Modul Interactive Response și modul Interactive Exam 

 Select response modes (Selectare moduri răspuns): În modul interactive 

response, deschide/închide panoul Mode. 

 Start/Pause (Pornire/pauză): Pornește sau staționează activitatea. 

 Up Key (Tastă sus): Schimbă întrebări și selectează moduri de răspuns. 

 Down Key (Tastă jos): Schimbă întrebări și selectează moduri de răspuns. 

 OK: Confirmă o selecție în software; trimite răspunsuri către Receptor. 

 Result: Deschide/închide fereastra Result. 

 Rank: Deschide/închide fereastra Rank. 

 F1: Schimbă modurile de afișare în panoul ID. 

 F2: După activitate, apăsați F2 pentru afișarea (sau ascunderea) răspunsului corect al 

întrebării curente. 

 Del: Șterge opțiunea sau trimite cifra către Receptor. (de ex., la acordarea notei 

pentru Răspuns oral, profesorul introduce 10 puncte, apoi poate apăsa Del pentru a 

șterge și reintroduce.) 

0~9: Introduce ID Student, acordă notă, omite întrebare, introduce răspuns standard 

pentru completarea spațiilor și așa mai departe.  

A~F: Introduce răspuns standard pentru întrebare cu mai multe variante de răspuns și 

așa mai departe.  

Y/N: Introduce răspuns standard pentru întrebare cu răspuns Adevărat sau Fals și așa 

mai departe.  

 

Student IQClick 

 

Descrierea 

caracteristicii 

Student IQClick este 

prevăzută ca toți cursanții 

să poată lua parte la 

răspunsurile și examinarea 

interactive. 

Dimensiune (mm) 1004922 

Temperatura de lucru 0-40°C 

Umiditatea de lucru 0-90% 

Sursa de alimentare 2 baterii AAA 

Unghi efectiv 360° 

Distanța 100m fără obstacole 

Taste 

Up Key (Tastă sus): Schimbă la întrebarea anterioară. 

Down Key (tastă jos): Schimbă la întrebarea următoare. 

Hand-up (Mâna sus): Utilizată pentru a lua parte la răspunsurile anticipative în Interactive 

Response. 

0～9: Introduce răspunsul pentru întrebarea cu spații de completat; schimbă  întrebarea. 
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A-F: Introduce răspunsul pentru întrebarea cu mai multe variante de răspuns. 

Y/N: Introduce răspunsul pentru întrebarea cu variantă de răspuns Adevărat sau Fals. 

Fn: Schimbă tasta în combinația de taste. 

Del: Șterge opțiunea sau trimite cifra către Receptor. 

Fn+Hand-up: Pune o întrebare în timpul activității. 
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Capitolul 2 Conectarea receptorului USB 

 

Conectați receptorul USB într-un port USB liber al PC-ului înainte de pornirea IQ Interactive Education 

Platform. Receptorul USB este utilizat pentru primirea semnalului emis de la IQClicks și înregistrarea IQ 

Interactive Education Platform cu verificarea hardware. 

 

Capitolul 3 IQ Interactive Education Platform (pentru IQBoard) 

3.1 Pornirea IQ Interactive Education Platform 

 

 

 Interactive Response (Răspuns interactiv): oferă peste 10 moduri diferite de răspuns, cum ar fi 

Preemptive Response, Elimination și așa mai departe. 

 Interactive Exam (Examinare interactivă): Realizează o examinare pentru clasă și bifează automat și 

marchează testele. 

 Response Setting (Setare răspuns): Setează Interactive Response și Interactive Exam. 

 Hardware Setting (Setare hardware): Autentifică Teacher IQClick și Student IQClick în sistem și 

butoanele de test.  

 

Notă: Software-ul IQClick va afișa un mesaj de eroare “Hardware isn’t connected!” dacă 

nu este conectat niciun receptor USB. 
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 Query: Creează și exportă rapoarte de activitate după clasă, cursant sau activitate. 

 Apăsați “list settings”: lista cursanților se poate stabili să afișeze după nume, nr. cursant sau nr. loc. 

 

3.2 Setare pentru IQClick 

3.2.1 Setarea IQClick 

Fiecare IQClick are un nr. după setările din fabrică. Puteți schimba sau reseta nr. pentru Teacher IQClick și 

Student IQClick. Puteți reseta IQClick No. după cum urmează: 

 

Seria A 

Teacher IQClick: 

1. Apăsați “Mode+Up” pentru a schimba în mod input digital; 

2. Introduceți Nr. profesor (Teacher No.) de care aveți nevoie; 

3. Apăsați “OK”; apoi pătratul Teacher No. corespunzător din zona Teacher Setting va deveni verde, în 

timp ce acest Teacher No. va fi afișat în colțul din stânga sus al LCD-ului. 

 

Student IQClick: 

1. Apăsați “Fn+Up” pentru a schimba în mod input digital; 

2. Introduceți Seat No. de care aveți nevoie; 

3. Apăsați “Send”, apoi acest Seat No. va fi afișat în zona Student Setting. 

4. Apăsați “Hand-up” pentru a confirma, apoi pătratul Seat No. corespunzător din zona Student Setting va 

deveni verde, în timp ce acest Seat No. va fi afișat în colțul din stânga sus al LCD-ului. 

 

Seria B 

Teacher IQClick: 

Apăsați Teacher No. de care aveți nevoie, apoi pătratul Teacher No. corespunzător din zona Teacher 

Setting va deveni verde. 

 

Student IQClick: 

1. Apăsați Seat No. de care aveți nevoie, apoi acest Seat No. va fi afișat în zona Student Setting. 

2. Apăsați “Hand-up” pentru a confirma, apoi pătratul Seat No. corespunzător din zona Student Setting va 

deveni verde. 
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Export: exportă setările IQClick și salvează ca format de fișier cdh în computer pentru utilizarea ulterioară. 

Import: importă fișierul de format cdh salvat înainte. 

Delete: șterge un Teacher No. sau Seat No. selectate.  

Clean: șterge toate setările Teacher IQClick și Student IQClick. 

3.2.2 Testarea IQClick 

Puteți testa fiecare buton de pe IQClick atunci când indicatorul Connection Status are culoarea verde iar 

setarea IQClick a fost finalizată. Procedați după cum urmează: 

1. Dacă utilizați Seria A, apăsați un buton de pe IQClick, apoi apăsați “OK” sau “Send”. 

Dacă utilizați Seria B, apăsați un buton de pe IQClick.  

2. IQClick Name, No. ID, și denumirea butonului vor fi afișate pe zona de testare (Testing). 

3. Verificați dacă informațiile din zona IQClick Testing pot corespunde butonului pe care l-ați apăsat. 

Notă:  

1. Înainte de setarea IQClick, asigurați-vă că indicatorul Connection Status este verde, ceea ce 

înseamnă reușita conexiunii dintre Receptor și IQClick. În caz contrar, re-conectați Receptorul. 

2. În timpul setării Student IQClick, puteți apăsa  pentru a elimina conținutul zonei No. Student 

Setting și a reintroduce. 
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3.2.3 Managementul clasei (Class Management) 

Apăsați “System Settings “, introduceți fereastra “Class Management”. Puteți regăsi Class Settings, Subject 

Settings și Teacher Settings în Class Management. 

3.2.3.1 Setări clasă (Class Settings) 

În Class Settings, puteți adăuga, șterge, edita, importa sau exporta baze de date despre clasă și puteți 

adăuga, șterge, edita sau grupa informații privind cursanții. 

 



Returnstar Interactive Technology Group Co., Ltd. 

 

 92 

3.2.3.2 Subject Settings (Setări subiecte) 

În Subject Settings, puteți adăuga, șterge, edita, importa sau exporta baze de date cu subiecte. 

 

3.2.3.3 Teacher Settings (Setări profesor) 

În Teacher Settings, puteți adăuga, șterge, edita, importa sau exporta baze de date privind profesorii. În plus, 

profesorul poate fi raportat la clasa și materia de care acesta/aceasta se ocupă. 

 

 
Notă: Doar administratorul IQClick Software poate introduce setări în IQClick și Class Management.  
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3.2.4 Editare chestionar interactiv (Edit Interactive Quiz) 

3.2.4.1 Introducere întrebare (Insert Question) 

Puteți adăuga una sau mai multe întrebări în pagini. Operațiunea este după cum urmează: 

1. Apăsați pictograma tipului de întrebare pe care doriți să o introduceți în panoul Question Setting. 

2. Apăsați “Insert”. 

  
 

3. Tipul întrebării selectate va fi indicat pe pagina curentă. 

 

 

 

Notă:  

1. Puteți introduce doar o întrebare interactivă per pagină. 

2. Pentru a schimba tipul întrebării, selectați pur și simplu o altă pictogramă de întrebare și 

apăsați pe “Insert”. 

3. Puteți șterge întrebarea introdusă apăsând “Delete”. 

4. Vote is not accessed under Interactive Exam mode. 
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3.2.4.2 Editare întrebare (Edit Question) 

Puteți edita întrebările interactive pe care le introduceți. Operațiunea este după cum urmează: 

1. Activați caseta de text Title sau Option. Realizați una dintre următoarele acțiuni: 

1) Faceți dublu clic pe caseta detext Title sau Option; 

2) Apăsați “Insert Text” și caseta de text Title sau Option. 

3) Selectați caseta de text Title sau Option și apăsați  în Marquee Handles. 

 

2. Editați întrebarea în caseta de text. 

3. Pentru a ieși din caseta de text, apăsați pur și simplu pe orice parte liberă a paginii.  

 

 

Notă:  

1. Puteți trage caseta de text de titlu sau opțiune pentru a schimba poziția. 

2. Nu puteți introduce text în spațiu atunci când introduceți o întrebare cu spații de completat. 

3. Puteți face dublu-clic pe “OK” pentru personalizarea proprietăților butonului, precum numele și fundalul. 
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3.2.4.3 Save Paper (Salvare document) 

După finalizarea editării întrebărilor, apăsați „Save” pentru salvarea documentului ca format de fișier cdf. 

3.2.5 Mod Interactive Response 

3.2.5.1 Deschidere document (Open Paper) 

Apăsați  în bara de instrumente Common Tools și selectați fișierul cdf pregătit pentru a deschide.  

3.2.5.2 Setările Response 

Puteți personaliza efectul răspunsului pentru modul Interactive Response. 

Response Settings: 

 Apăsați  “Response Settings” pe panou. 

 

 

2. Setările următoare sunt disponibile în tab-ul Interactive Response: 

 

Response By (Răspuns după): Sunt accesibile răspunsul individual și răspunsul de grup. 

Feedback Settings (Setări feedback): 

Arată varianta corectă după răspuns: atunci când procesul de răspuns este oprit sau finalizat, răspunsurile 

corecte se afișează pe pagina de întrebări și rezultate (Result). 

 

Permite cursantului să obțină rezultatul (suportă doar IQClick Seria A): atunci când procesul de răspuns este 

oprit sau finalizat, apăsați “Fn+Send” în Student IQClick pentru afișarea rezultatului răspunsului și varianta 

corectă pe LCD.   
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De ex. 

Varianta corectă de răspuns pentru o întrebare este opțiunea B, dar cursantul a ales 

opțiunea A. Atunci când procesul de răspuns este oprit sau se finalizează: 

 “Show response result” este selectat. 

Apăsând „Fn+Send” pe Student IQClick: 

“Show response result and correct 

answer” este selectat. 

Apăsând „Fn+Send” pe Student IQClick: 

 

LCD 

 

LCD 

Sound Effect Settings (Setări efecte sonore): Puteți adăuga efect sonor la pornirea răspunsului, oprirea 

răspunsului și așa mai departe. Formatul de fișier audio suportat este wav. 

3.2.5.3 Accesarea modului Interactive Response 

Apăsați  “Interactive Response” pe panou; 

 

După introducerea modului Interactive Response, puteți vedea pagina cu întrebări, panou ID, zona modului 

de răspuns, temporizator, bara de instrumente mobilă și placa de instrument. 

 

Question Page (Pagina cu întrebări): afișează întrebări interactive și răspunsuri corecte. Se pot realiza 

adnotări și alte operațiuni în pagina întrebărilor (Question Page). 

ID Panel (Panou ID): toate numerele locurilor (Seat No.) cursanților vor fi afișate în această zonă. Culoarea 

fundalului pentru Seat No. indică statusul de răspuns al cursantului. 
 

1. Culoare fundal pentru Seat No. 



Returnstar Interactive Technology Group Co., Ltd. 

 

 97 

Culoare Descriere 

 

Fundalul negru indică faptul că locurile nr. 1, 2 și 3 nu au răspuns. 

 

 

Fundalul albastru indică faptul că locul nr.1 a răspuns. Dacă locul nr.1 își schimbă 

opțiunea în timp ce trimite răspunsul, fundalul va deveni albastru deschis. 

 

După oprirea procesului de răspuns și afișarea răspunsului corect, fundalul roșu indică 

faptul că locul nr.1 a oferit un răspuns greșit. 

 

După oprirea trimiterii răspunsurilor și afișarea răspunsului corect, fundalul verde va 

indica faptul că locul nr.1 a oferit un răspuns corect. 

2. Există două moduri de a schimba statusul între Student ID și Response Status: 

1) Apăsați pictograma  lângă panoul ID; 

2) Apăsați “F1” pe Teacher IQClick. 

 

ID student 

 

Status răspuns 

 

3. Mergeți la partea anterioară/următoare a ID-ului de cursant: 

Apăsați pictogramele  în panoul ID pentru a merge la partea anterioară sau următoare a Student ID. 

Puteți seta trecerea automată apăsând pictograma  în panoul ID. 

 

Timer (Temporizator): Puteți seta timpul de răspuns pentru fiecare întrebare. După începerea răspunsului, 

temporizatorul va număra invers în mod automat. Fundalul verde indică pornirea răspunsului, galben indică 

pauza, iar roșu indică stop. 

 

3.2.5.4 Start Interactive Response (Pornire răspuns interactiv) 

Folosind IQClick, puteți porni diverse moduri de răspuns. 
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1. Selectare mod de răspuns: 

IQ Interactive Education Platform selectează automat un mod de răspuns adecvat pentru întrebarea din 

pagina curentă. Modul de răspuns selectat va fi afișat în colțul din dreapta sus al paginii. Puteți apăsa  

pe Teacher IQClick pentru a selecta alte moduri de răspuns. 

 

2. Pornire răspuns: 

După pornirea procesului de răspuns, cursanții pot oferi răspunsul prin Student IQClick.  pe Teacher 

IQClick este pentru pauză de răspuns,  pentru final. 

Mod 

răspuns 

Descriere 

Testing 

Response 

Funcție: Toți cursanții pot oferi răspuns. 

Profesor: Selectați modul, apoi apăsați  pentru a porni răspunsul. 

Student: după trimiterea răspunsurilor la Receptor, culoarea de 

fundal a numărului locului aferent va deveni albastru.  

Preemptive 

Response 

Funcție: Permite primului cursant care oferă varianta corectă de 

răspuns să trimită răspunsul.  

Profesor: Selectați modul, apoi apăsați  pentru a primi dreptul de 

răspuns. 

Cursant:  

1) Apăsați  pentru a primi dreptul de răspuns.  

2) Nr. locului care primește drept de răspuns se va afișa în panoul ID 

și jumătatea Tool Plate, apoi respectivul cursant poate trimite 

răspunsul. 

Multiple 

Preemptive 

Response 

Funcție: Permite ca cel mult 10 cursanți să primească drepturi de 

răspuns. 

Profesor:  

1) Selectați modul, apoi apăsați  pentru a afișa fereastra popup 

Student Numbers Settings.  

2) Apăsați  și  pentru a derula crescător sau descrescător 

numerele cursanților, apoi apăsați  pentru a porni 
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răspunsul. 

 

Cursant: 

1) Apăsați  pentru a primi dreptul de răspunss. 

2) Cursanții care primesc drept de răspuns se vor afișa în panoul ID și 

partea mediană a Tool Plate. 

3)  IQ Interactive Education Platform va opri procesul de preluare 

atunci când cursanții ating numărul stabilit. 

4)  Acești cursanți pot începe să trimită răspunsurile. 

Elimination 

Funcție: Cursanții care oferă răspunsul corect vor introduce 

răspunsul următor, în timp ce persoana ca pierde este eliminată.  

Profesor: Selectați modul, apoi apăsați  pentru a porni răspunsul. 

Student: Trimiteți răspunsurile către receptor. Atunci când procesul 

de răspuns se încheie, culoarea de fundal a numărului locului aferent 

va deveni albastru dacă răspunsul este corect. Dacă fundalul are 

culoarea gri, aceasta înseamnă că cursantul a fost eliminat.   

Appointed 

Response 

Funcție: Doar cursantul desemnat de profesor poate oferi răspunsul. 

Profesor:  

1) Selectați modul, apoi apăsați . 

2) Alegeți un student din fereastra care apare la apăsarea butoanelor 

 și  pe IQClick, apoi apăsați . 

3) Apăsați  pentru a porni răspunsul. Culoarea de fundal pentru 

numărul locului nedesemnat este gri. 

 

Cursant: Cursantul desemnat poate oferi răspunsul. 

Random 

Response 

Funcție: IQ Interactive Education Platform alege aleatoriu un cursant 

care să răspundă la întrebare. 

Profesor: Selectați modul, apoi apăsați , iar sistemul va alege un 

număr de loc și îl va afișa la partea din centru a Tool Plate. 
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Cursant: Oferă răspunsul. 

Vote 

Funcție: Funcționează doar cu activitate Vote. Rezultatul votului se va 

afișa în pagina de întrebări ca diagramă în batoane sau circulară, în 

timp real. 

Profesor: Selectați modul, apoi apăsați  pentru a începe 

acordarea voturilor. 

Cursant: Începeți acordarea voturilor. 

Transient 

Quiz 

Funcție: Profesorul poate introduce o întrebare suplimentară (inclusiv 

variante multiple de răspuns, completare de spații și Adevărat sau 

Fals) în pagina curentă. 

Profesor: 

1) Profesorul poate stabili o întrebare verbal sau direct în scris pe 

pagina curentă. 

2) Selectați modul și apăsați , apoi trebuie să apară fereastra de 

selecție. 

3) Selectați un tip de întrebare, apoi apăsați  pentru a porni 

răspunsul. 

4) Profesorul poate trimite un răspuns corect către Receptor prin 

IQClick în timp ce cursantul răspunde, dar acesta se poate 

introduce din fereastra de răsuns corect după ce se finalizează 

procesul de răspuns. 

 

Cursant: Oferă răspunsul. Culoarea de fundal pentru numărul locului 

care a oferit răspunsul este albastru. 

Oral 

Response 

Funcție: Profesorul poate stabili o întrebare verbal sau direct în scris 

în pagina curentă. Cursanții obțin dreptul de a răspunde și oferă 

răspunsul verbal. 

Profesor: 

1) Stabilește întrebarea;  

2) Selectează modul și apasă  pentru a lăsa cursanții să obțină 

dreptul de răspuns. 

3) După ce cursantul finalizează răspunsul, va apărea o fereastră de 

marcare. Apăsați  și  pe Teacher IQClick pentru a selecta un 
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scor. 

Cursant: 

1) Apăsați  pe IQClick pentru a primi dreptul de răspuns.  

2) Cursantul care primește dreptul de răspuns va fi afișat în panoul 

ID și partea din mijloc a Tool Plate. 

3) Acest cursant poate începe să răspundă. 

Auto 

Roll-call 

Funcție: IQ Interactive Education Platform poate afișa un raport 

nominal pentru profesor. Doar cursanții participanți se pot alătura 

activităților următoare. 

Profesor: Selectează modul și apasă  pentru a începe apelul 

nominal. 

Cursant: În timpul apelului nominal, cursanții apasă orice tastă pe 

IQClick pentru validare. 

Temporary 

Group 

Funcție: Schimbă temporar grupurile în activitate. 

Profesor:  

1) Selectează modul și apasă  pentru accesarea ferestrei de 

grup. 

2) Apăsați “OK” pentru confirmare după finalizarea grupării. 

Cursant: Apăsați “1” pe IQClick pentru accesarea grupului Nr.1, “2” 

pentru Grupul Nr. 2, și așa mai departe.  

 

3.2.5.5 Show Result (Afișare rezultat) 

IQ Interactive Education Platform poate afișa Result pentru fiecare întrebare după finalizarea răspunsului. 

După oprirea răspunsului, apăsați  pe Teacher IQClick pentru afișarea ferestrei Show Result. Puteți 

schimba între tab-ul Summary și tab-ul Detail apăsând “F1” pe Teacher IQClick. Apăsați “F2” pentru 

afișare/ascundere răspuns corect.  

 

 

Notă: Pe durata activității, cursantul poate apăsa “Fn+Hand-up” pentru a pune o întrebare. 
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3.2.5.6 Rank (Clasament) 

Clasifică rezultatele răspunsului cursanților după punctaj și timp. 

Pentru afișarea ferestrei Rank, apăsați  pe Teacher IQClick după finalizarea răspunsului. 

 

3.2.5.7 Peek at Correct Answer (Consultare răspuns corect) 

IQ Interactive Education Platform permite profesorului să verifice răspunsurile corecte înainte sau pe durata 

trimiterii răspunsului.  

 

Pentru consultarea răspunsului corect, operarea este după cum urmează: 

1. Mergeți la întrebarea al cărui răspuns doriți să îl consultați apăsând  sau  pe Teacher IQClick. 

2. Apăsați “F2” sau “Mode+OK” pe Teacher IQClick, răspunsul corect se va afișa pe LCD.  

3. Pentru a verifica răspunsul corect pentru alte întrebări, repetați pașii de mai sus. 

3.2.6 Mod Interactive Exam  

Profesorul poate edita testele în IQ Interactive Education Platform, apoi imprimați-le și livrați-le fiecărui 

cursant. Apoi cursanții selectează răspunsurile după Student IQClick. IQ Interactive Education Platform va 

colecta răspunsurile și vor marca automat testul, apoi afișează rezultatul imediat și generează forma 

raportului în format comun. 

3.2.6.1 Print Test Paper (Imprimare test) 

IQ Interactive Education Platform va prezenta automat testul pentru imprimare. 

 

Există două moduri de imprimare a testelor: 

1) Deschideți un test în format cdf și selectați “File > Print Paper” pentru imprimare.  

2) Deschideți un test în format cdf și previzualizați mai întâi din “File > Preview Paper”, apoi apăsați “Print” în 

fereastra Preview pentru imprimare. 
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3.2.6.2 Response Settings (Setări răspuns) 

Puteți personaliza efectul răspunsului pentru modul Interactive Exam. 

 

Response Settings: 

Apăsați  “Response Settings” pe panou. 
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2. Setările următoare sunt accesibile în tab-ul Interactive Exam: 

 

Durata examinării: 1.5 ore, în mod implicit. 

Setări feedback:  

Show correct answer after response (Arată răspunsul corect după trimiterea răspunsului): atunci când 

procesul de răspuns este oprit sau se finalizează, rezultatul răspunsului cursantului (corect sau greșit) se va 

afișa pe IQ Interactive Education Platform și, de asemenea, și pe LCD-ul Student IQClick LCD. 

Permite cursantului să obțină rezultatul (suportă doar IQClick Seria A): atunci când procesul de răspuns este 

oprit sau finalizat, apăsând “Fn+Send” pe Student IQClick pentru afișarea rezultatului răspunsului și 

răspunsul corect pe LCD. 

 

De ex.. 

Răspunsul corect al întrebării nr. 8 este B, dar cursantul a ales opțiunea A. Atunci 

când procesul de răspuns este oprit sau se finalizează: 

 “Show response result” este selectat. 

Apăsați „Fn+Send” în Student IQClick: 

“Show response result and correct 

answer” este selectat. 

Apăsați „Fn+Send” în Student IQClick: 

 

LCD 

 

LCD 

Sound Effect Settings (Setări efect sonor): Puteți adăuga efect sonor la pornirea răspunsului, oprirea 

răspunsului și așa mai departe. Formatul de fișier audio suportat este wav. 

3.2.6.3 Accesarea modului Interactive Exam 

 Apăsați  Interactive Exam pe panou; 
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După accesarea modului Interactive Exam, puteți vedea zona informațiilor despre test, panoul ID, 

temporizator, bara de instrumente mobilă și tool plate. 

 

Test Paper Information Area (Zona informațiilor de test): În această zonă sunt afișate informații despre 

clasă, materie, întrebări și punctaj total. 

ID Panel (Panou ID): Primul rând este Seat No. (Număr loc), al doilea afișează numărul întrebării. De ex.. 

 înseamnă că elevul de pe locul nr. (Seat No.) 1 este la momentul curent la întrebarea Nr. 1. 

 

Culoare de fundal pentru numărul locului și numărul întrebării: 

 Culoare Descriere 

 

 

Fundalul de culoare neagră indică faptul că locurile cu numerele 1, 2 și 3 nu au oferit 

încă răspunsul. 

 

Pe durata procesului examinării, fundalul de culoare galbenă a locului nr.1 înseamnă 

că acest cursant a început să răspundă dar nu a finalizat această acțiune; fundalul 

albastru al numărului întrebării indică faptul că s-a răspuns la întrebarea nr. 1. 

 

Pe durata procesului examinării, fundalul albastru al numărului locului indică faptul că 

s-a răspuns la toate întrebările. 

 

După finalizarea examinării și afișarea răspunsului corect, fundalul de culoare roșie la 

numărul întrebării indică faptul că la respectiva întrebare s-a răspuns greșit. 
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După finalizarea examinării și afișarea răspunsului corect, culoarea verde a 

fundalului la numărul întrebării indică faptul că întrebarea a primit un răspuns corect. 

 

Timer (Cronometru): Puteți seta timpul examinării. După începerea examinării, cronometrul va măsura 

timpul în ordine inversă, în mod automat. Fundalul de culoare verde indică pornirea, galben indică pauza, iar 

roșu indică stop. 

 

 

3.2.6.4 Start Interactive Exam (Pornirea examinării interactive) 

Start: Apăsați  în Teacher IQClick pentru a începe examinarea. Timpul va fi contorizat descrescător. 

Cursanții pot oferi răspunsuri prin Student IQClick. 

Pause: Apăsați  în Teacher IQClick pentru a face pauză în timpul examinării. Cursanții nu pot oferi 

răspunsuri pe durata pauzei de examinare. 

Stop: Apăsați  pentru încheierea examinării. După ce timpul a expirat, examinarea se va încheia 

automat. 

3.2.6.5 Take Interactive Exam (Realizarea examinării interactive) 

Există două modalități de schimbare a numărului întrebării:  

1. Apăsați  sau  în Student IQClick pentru a merge la întrebarea anterioară sau la cea următoare. 

Question No. va fi afișat în colțul din stânga sus pe LCD. 

2. Apăsați “Fn+2” în Student IQClick și introduceți un număr al întrebării pentru a omite întrebarea de care 

aveți nevoie. 

Trimiteți răspunsurile către receptor:  

Introduceți răspunsurile în IQClick potrivit diferitelor tipuri de întrebări din testul imprimat, apoi trimiteți către 

Receptor. IQClick seria A, poate suporta introducerea răspunsurilor pentru toate întrebările apoi le trimite 

către Receptor laolaltă, prin apăsarea “Send”. Dacă utilizați IQClick Seria B, trebuie să trimiteți răspunsurile 

la întrebări unul câte unul. 

3.2.6.6 Show Result in ID Panel (Afișare rezultat în panoul ID) 

După examinare, puteți apăsa “F2” sau “Mode+OK” pentru afișarea rezultatului răspunsului la întrebarea din 

panoul ID. Cursanții pot verifica rezultatele răspunsurilor cu  sau  în IQClick. 

3.2.6.7 Show Response Result of Class (Afișare rezultat răspuns pentru toată clasa) 

După examinare, profesorul poate verifica rezultatul examinării pentru întreaga clasă, ca rezumat sau în 

detaliu. 

 

Pentru afișarea rezultatului răspunsurilor: 

1. Apăsați  în Teacher IQClick pentru a deschide fereastra Show Response Result. 

2. Apăsați “F1” în Teacher IQClick pentru a schimba tab-urile Summary și Detail. Apăsați “F2” pentru 

afișarea/ascunderea răspunsurilor corecte. 
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3.2.6.8 Rank (Clasament) 

De îndată ce examinarea se încheie, IQ Interactive Education Platform va aranja automat rezultatele 

cursanților în ordine după punctaj sau după timp.  

 

Pentru afișarea ferestrei Rank, apăsați  în Teacher IQClick după încheierea examinării. 

 

3.2.6.9 Peek at Correct Answer (Consultarea răspunsului corect) 

IQ Interactive Education Platform permite profesorului să verifice răspunsurile corecte înainte sau în timpul 

examinării.  

Pentru consultarea răspunsului corect, trebuie urmați pașii următori: 

1. Mergeți la întrebarea al cărui răspuns doriți să îl verificați apăsând  sau  în Teacher IQClick. 

2. Apăsați “F2” sau “Mode+OK” în Teacher IQClick, răspunsul corect se va afișa pe LCD.  

3. Pentru verificarea răspunsurilor corecte pentru alte întrebări, repetați pașii de mai sus. 
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Capitolul 4 IQ Interactive Education Platform (pentru PPT) 

4.1 Pornirea IQ Interactive Education Platform 

Rulați Microsoft Office PowerPoint, puteți vedea meniul IQClick și bara de instrumente IQClick adăugate în 

fereastra PowerPoint. 

 

Apăsați “User Login” în meniul IQClick, apoi va apărea fereastra de autentificare ca mai jos: 

 

IQ Interactive Education Platform oferă profesorilor un cont temporar de utilizator pentru pornirea activității 

temporare fără setarea informațiilor privind clasa. Puteți adăuga alte conturi de utilizator din “Teacher 

Settings” după autentificarea de către administrator. 

 

  

Notă: Contul de utilizator implicit pentru administrator este “administrator”, parola nu este 

stabilită. După prima autentificare, schimbați parola și memorați-o.  
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User Login (Autentificarea utilizator): Înainte de începerea activității prin IQClick pentru Powerpoint, mai 

întâi autentificați-vă. 

Hardware Setting: Deschideți fereastra Hardware Setting pentru autentificare în Teacher IQClick și Student 

IQClick în sistem și butoanele de test.  

Class Setting: Deschideți fereastra Class Setting pentru stabilirea bazei de date pentru clasă, materie și 

profesor. 

Question Setting: Deschideți fereastra Question Settings pentru stabilirea tipului și răspunsului la 

întrebarea din pagina curentă. 

Interactive Response: Oferă 10 moduri de răspuns diferite, precum Preemptive Response, Elimination și 

așa mai departe. 

Response Setting: Deschideți fereastra Response Setting pentru setarea Interactive Response și 

Interactive Exam. 

Query (Interogare): Creează și exportă rapoarte de activitate după clasă, student sau activitate. 

4.2 Setarea IQClick 

Pentru IQClick Settings, IQClick Testings, Subject Settings și Teacher Settings, consultați Capitolul 5 IQ 

Interactive Education Platform (pentru IQBoard) din acest manual de utilizare. 

4.3 Editare Interactive Quiz 

Puteți adăuga întrebări interactive în paginile PowerPoint prin IQ Interactive Education Platform. 

4.3.1 Introducere întrebare 

1. Apăsați  “Question Settings” în bara de instrumente IQClick, apoi va apărea 

fereastra Quiz Settings. 

 

 

2. Selectați tipul întrebării, numărul opțiunii, răspunsul corect, timpul și punctajul pentru întrebare. 
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3. Apăsați “Insert”. Întrebarea pe care ați selectat-o va fi introdusă în pagina curentă a PowerPoint. 

 

 

4.3.2 Editare întrebare (Edit Question) 

Puteți edita întrebările interactive introduse. Operațiunea este următoarea: 

1. Activați caseta de text Title sau Option.  

2. Editați întrebarea din caseta de text. 

3. Pentru a ieși din caseta de text, apăsați pur și simplu pe orice parte liberă a paginii.  

 

 

4.3.3 Modificarea întrebării (Modify Question) 

Pentru a modifica tipul întrebării pentru o întrebare introdusă, apăsați “Modify” din fereastra Quiz Settings. 

Notă: O pagină în PowerPoint poate cuprinde o singură întrebare interactivă. 



Returnstar Interactive Technology Group Co., Ltd. 

 

 111 

 

4.3.4 Ștergere întrebare (Delete Question) 

Există două metode de ștergere a întrebării introduse: 

1. Apăsați “Delete Current Question” în fereastra Quiz Settings. 

2. Ștergeți direct pagina curentă în PowerPoint. 

 

4.3.5 Informații despre întrebare (Question Information) 

Puteți apăsa “Information” în fereastra Quiz Settings pentru vizualizarea informațiilor despre întregul test, 

inclusiv numărul total și marcajul întrebărilor, timpul total de răspuns și așa mai departe. 
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4.4 Rîspuns interactiv (Interactive Response (pentru PowerPoint)) 

După finalizarea setărilor de mai sus, puteți începe activitatea prin modulul IQClick Interactive Response 

încorporat în PowerPoint.  

 

Pentru a porni răspunsurile interactive: 

1. Deschideți fișierul PowerPoint interactive exma pregătit. 

2. Apăsați “Question Settings” în bara de instrumente IQClick pentru a personaliza activitatea.  Puteți omite 

acest pas și utiliza setările implicite. 

3. Apăsați “Interactive Response” în bara de instrumente IQClick pentru introducerea modului Interactive 

Response. 

4. Selectați un mod de răspuns pentru începerea activității. 

 

 

Notă: Modul de setare a întrebărilor și răspunsurilor este același ca și pentru setările IQClick 

Software (pentru IQBoard), consultați Capitolul 5 IQClick Software (pentru IQBoard) 
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Capitolul 5 Interograrea (Query) 

Există două moduri pentru accesarea ferestrei Query: 

1. Apăsați pictograma  în bara de instrumente Interactive Response. 

2. Selectați după cursant (By Student), după clasă (By Class), sau după activitate (By Activity) din Query în 

meniul Common Menu. 

5.1 Selectarea după clasă (By Class) 

 

Score Rank List (Listă ordine scoruri): Arată scorul activităților anterioare, inclusiv număr cursant, nume 

cursant, număr grup, nota, timp de răspuns și clasamentul, frecvența notei de trecere a clasei și frecvența 

totală a notelor, etc. 

Response Details (Detalii trimitere răspuns): Arată rezultatul răspunsurilor pentru fiecare cursant 

(inclusiv nota, timpul etc.) pentru fiecare întrebare din activitățile anterioare. 

Answer Details (Detalii răspuns): Arată răspunsul corect și timpul fiecărei întrebări în activitățile 

anterioare. 

Roll-call (Apel nominal): Arată detaliile participării unei clase într-o singură activitate, inclusiv timpul 

prezenței, status prezent și absent pentru fiecare cursant și număr total prezențe și absențe. 
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5.2 Selecția după cursant (By Student) 

 

Statistical Table of Score (Tabel statistic de scor): Arată rezultatul activității unui singur cursant pe o 

perioadă de timp, inclusiv informații despre activitate, nota și poziția individuală, nota medie a clasei, etc. 

Țineți apăsat “Ctrl” pentru a selecta mai multe activități. 

Response Details (Detalii trimitere răspuns): Arată detaliile unei singure activități pentru un singur 

cursant. 

Roll-call Details (Detalii apel nominal): Arată detaliile participării pentru un cursant pe o perioadă de 

timp, inclusiv timpul de apel nominal, prezențe și absențe, etc. Țineți apăsat pe “Ctrl” pentru a selecta mai 

multe activități. 

5.3 Selecția după activitate (By Activity) 

 

Calculate score weighted (Calculare scor ponderat): Calculați media ponderată a scorului pentru mai 

multe activități ale clasei și raportați scorurile finale. 
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Pentru calcularea scorului ponderat: 

1. Apăsați și țineți apăsat “Ctrl” pentru a selecta două sau mai multe activități. Apoi apăsați “Report” pentru 

accesarea ferestrei Statistic. 

 

2. Selectați o activitate și introduceți proporția (Proportion) pentru aceasta. Apoi apăsați “Calculate”. IQ 

Interactive Education Platform va calcula pentru dvs ponderea fiecărei activități.  

 

De ex., activitatea A cu proporția 7, activitatea B cu proporția 3.  

Ponderile pentru acestea se calculează după cum urmează:  

Pondere A=Proporție A / (Proporție A+ Proporție B) 

Pondere B= Proporție B/ (Proporție A + Proporție B) 

Astfel că ponderea A=7/(7+3)=7/10; ponderea B=3/(7+3)=3/10. 

 

3. Apăsați “Report”, apoi IQ Interactive Education Platform vă va oferi un raport privind scorurile, 

clasamentul cursanților și așa mai departe, potrivit ponderilor stabilite. 

5.4 Operarea în formularele de raport (Form Report) 

După ce apăsați butonul “Query”, fereastra report form se va afișa, diferite opțiuni de interogare generează 

diferite forme de raport. Astfel: 

 

Export (Exportă): convertește formularul raportului în fișiere format HTML, txt, xls și salvează pe HDD. 

Send E-mail (Trimitere e-mail): trimite raportul ca atașament pe e-mail. 
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Print (Imprimă): imprimă formularele de raport. 

Partea IV Versiune și întrebări frecvente 

Capitolul 1 Declarație privind versiunea 

IQ Interactive Education Platform reprezintă un set de programe software care se actualizează constant. În 

plus, la actualizarea Symbol Library și Resource Library, vom reînnoi continuu funcțiile acestora și vor 

realiza îmbunătățiri. Astfel că recomandăm în mod special clienților să realizeze actualizarea regulată a 

software-ului.  

Capitolul 2 Întrebări frecvente 

1. În timp ce instalez software-ul, fereastra interfeței de instalare este întinsă; și, între timp, atunci 

când pornesc software-ul, afișează un mesaj de eroare neobișnuit. Ce pot face? 

Această problemă nu va apărea dacă computerul este în uz normal. Dacă se întâmplă, motivul principal este 

că DPI de afișare este prea ridicat. Faceți clic dreapta pe desktop-ul windows și accesați meniul “Properties”, 

alegeți “Settings” apoi “Advanced”, modificați DPI la “Normal size (96dpi)” în DIP Setting. Apoi reporniți 

computerul.  

 

2. După utilizarea funcției Screen Record, nu pot vedea unele ferestre în fișierul video salvat, cum ar 

fi bara de instrumente derulantă, fereastra de adnotare în modul Windows. Cum procedez? 

Aceasta se întamplă deoarece sistemul înregistrează doar zona de operare implicit, pentru a controla 

dimensiunea fișierelor video. Dacă doriți să înregistrați toate ferestrele și bara de instrumente derulantă, 

înainte de înregistrare apăsați Screen Record, apoi apăsați Options în bara de instrumente secundară 

a Screen Record, selectați “Record all areas”.  

 

3. Atunci când utilizez și scriu pe tablă cu ajutorul software-ului, sistemul răspunde lent, sau 

procesul de scriere este intermitent. Ce se întâmplă?? 

Computerul nu funcționează normal sau este prea multă memorie ocupată. Închideți unele aplicații sau 

reporniți computerul. 

Sau, operarea sau forța de scriere este neuniformă. Uneori forța este prea mică pentru a fi sesizată. 

 

4. La introducerea unui fișier video în pagina tablei și redarea acestuia, imaginile video nu pot fi 

afișate, dar apare un ecran negru. Cum trebuie procedat? 

1) Fișierul video nu există deloc, selectați și introduceți din nou. 

2) Fișierul video a fost deja deteriorat, reparați și reintroduceți. 

3) Accelerarea hardware nu este suficientă, procedați după cum urmează: faceți clic dreapta pe desktop-ul 

windows, “Properties>Settings>Advanced>Troubleshoot” și setați “Hardware acceleration” din “None” pe 

locul 3.  

 

5. În timp ce utilizați instrumentul “Spotlight”, zona concentrată nu poate fi evidențiată, ce se 

întâmplă?  
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Motivul este calitatea culorii în sistem, care nu este suficientă să suporte această funcție software, faceți clic 

dreapta pe desktop-ul windows, accesați meniul “Properties”, selectați “Settings” apoi modificați “Color 

quality” la “Highest (32biți)”. 
 

Pentru întrebări, consultați centrul nostru de servicii sau distribuitorul local. 

 


